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Introduction

The Geomar TrackMaker61MK2 Data Logging System consists of a data acquisition program
Nav61MK?2 and associated PC computer data processing program TrackMaker61MK2. In ad-
dition to Windows 10 based data acquisition program for tablets and field laptop computers,
versions Navo1 MK2wm and Nav61MK2wg for Windows Mobile based devices were developed.
Legacy Nav61MK?2 programs were prepared also for Windows CE and hand held DOS based
loggers. The TrackMaker61MK2 program is backward compatible, it can process and recognizes
data file formats created with various versions of NAV61MK2 automatically.

1.1 About the TrackMaker61MK2

The TrackMaker61MK?2 is a Windows based program for IBM PC compatible computers
operating under Windows 10/7/XP/2000 or later. The program TrackMaker61MK2 is de-
signed to process data collected by a field computer under the control of any version of
data acquisition program Nav61MK2. The program can be used to position EM61-MK2
sensor based on recorded GPS/RTS data or by using a post-processed GPS file. The
program allows you also to convert data to Geonics DAT61MK?2 format, to convert to
ASCII text file format, to position field comments, generate position file for stand-alone
GPS positions (GXY), and to correct created XYZ files for a delay (latency) caused by
the system time constant.

Main function of this program is to position Geonics EM61-MK2 based on the recorded
GPS position, the instant heading of the system, the configuration of the system, and
several user specified filters. Configuration of the system is described by offsets of the
GPS antenna from the center of the EM61-MK2 sensor. The program calculates real
position of the instrument based on specified GPS antenna offset and direction of the
movement. However, it is highly recommended that GPS antenna is placed in the center
of the EM61-MK?2 sensor (or as close as possible) as this configuration provides the best
accuracy. Optionally elevation data, GPS quality parameters, and Roll, Pitch, and Yaw
values (latter three if RTS Slam is used) can be written to the output file. The program
corrects elevation data for the GPS antenna height. The program can process seven
different NMEA GPS messages recorded by data acquisition software NAV61MK2: a
pair GGA/GSA, GGA, POS, LLK, LLQ, GLL, and GGK (Trimble and Leica versions).
In addition program handles interface of pseudo-GGA (Robotics Total Station manu-
factured by Leica, Trimble, and several other brands) and psudo-GLL available in some
marine positioning systems.
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The TrackMaker61MK?2 also allows you to correct the collected GPS positions with post-
processed GPS files, and position data files created by Geonics data acquisition program
EM61MK2.

The TrackMaker61MK2 uses data files in Nav61MK?2 format which have extension name
P61. These are binary files with a record length of 27 bytes terminated by Line Feed
character. These files should not be edited using standard text editors. The program can
also process files with extension GXY. The GXY file contains stand-alone GPS posi-
tions available if the Nav61MK?2 program was used to collect GPS data only. These files
are also binary (same record length as standard Nav61MK?2 data files) and care should
be taken if they are viewed with text editors. Files GXY generated by any other Geomar
data acquisition program i.e. ML61MK2xpn, Nav38MK?2, Nav31, etc. are fully compat-
ible and they can be processed by TrackMaker61MK2.

One sample Nav61MK?2 data file, Test2.P61, and one external (postprocessed) GPS file

Trext18.txt are included on the program disk. They allow the user to become familiar
with running the TrackMaker61MK2 program.

1.2 Contents of TrackMaker61MK2 Distribution Disk

The TrackMaker61MK?2 software is supplied on one CD disk or USB memory disk. Disk
contains following files and directories:

SetupT61MK2 -  setup program for TrackMaker61MK2

SetupNav61MK2- installation for Windows 10 based data acquisition pro-
gram Nav61MK?2 (alternatively it is replaced by Nav61M-
K2wm or Nav61MK2wg programs for Windows Mobile)

Documentation -  directory containing all NAV61MK?2 and TrackMak-
er61MK2, and other available Geomar manuals in PDF
format.

DemoPrograms -  available demo versions for other Geomar programs.

The Software can be supplied on a CD disk or USB memory stick, or by download
from provided link to Geomar server. When electronic download is used files are often
named showing their version number, for example SetupT61MK2.exe can be posted as
SetupT61MK2_V209.exe to indicate that the setup program contains program Track-
Maker61MK?2 version 1.17.
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1.3 TrackMaker61MK2 Software Installation

TrackMaker61MK?2 software uses a setup program to load files necessary for data pro-
cessing onto your computer. The following section describes the installation process.

To install TrackMaker61MK2: Insert the TrackMaker61MK2 CD disk or USB drive into
CD drive or to USB connector. Alternatively use the SetupT61MK2 file in Windows
Explorer if the software was downloaded. Exit all Windows applications before installing
the program. From the Windows File Manager, select Run from the Windows System
menu (or simply press key Windows + R). The Run dialog box opens (Figure 1.1).

=7 Type the name of a program, folder, document, or Internet
= resource, and Windows will open it for you.

Open: Ch\Downloads\5etup TEIMK2.exe w

Cancel Browse...

Figure 1.1:  Run Dialog window

Alternatively browse for the file SetupT61MK2.exe in the CD or USB disk, or Windows
folder. Double click OK to launch the Setup program. Once the Setup determines your
computer configuration the Welcome window opens (Figure 1.2).

Do TrackMaker61MK2 Setup

Geomar Software Inc.
Welcome to the installer for TrackMaker6 TMK2 V2.09.

It is strongly recommended that you exit all Windows programs
befare continuing with this installation.

If you have any other programe running, please click Cancel,
close the programs, and run this setup again

Otherwise, click Next to cortinue

Cancel

Figure 1.2:  Welcome window

Read the text and click the Next button. A License Agreement window will be displayed
(Figure 1.3).
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08 TrackMaker61MK2 Setup

Terms And Conditions A
This program is provided "AS 15", Geomar Software Inc. is NOT responsible for any damage

(or damages) attributed to TrackMaker61MK2 or ts field component Nav&1MK2 (or equivalent
Mav81MK2wm and NavB1MK2wg). You are wamed that you use the program at your own

risk. No warranties are implied or given by Geomar Software or any representative.

This license cannct be sold or donated to a third person or company.

Usage

This package is a single user license only. The software can be installed on muttiple
computers. While the associated data acquisition program NavB1MK2 [requires Software Key)
can be used on one field computer only at any time the data processing program
TrackMaker61MKZ can be used on three computers simultaneously within the organization

Mot masimn ol 9

(@) i agree fo the tems of this license agreement:

(") 1 do not agree to the terms of this license agreement

| <Back | [ mexs | Coneel

Figure 1.3:  License Agreement window

Read the text and click the Next button. The Serial Number window will be displayed
(Figure 1.4).

08 TrackMaker61MK2 Setup

: ter your serial number and click Mext to continue.

Serial number is case sensitive. please use UPPER CASE for non numeric characters.
Senial Number:

s

Figure 1.4:  Serial Number window

Type the Serial Number into the provided box and press the Next button. (If you do not
know the Serial Number, you will not be able to continue.) This entry is case sensitive,
please use Upper Case for characters. The Installation Directory window opens (Figure
L.5).
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B TrackMaker61MK2 Setup

Where would you like TrackMakerb1MK2 to be installed?

The software will be installed in the folder listed below. To select a different location, ether type in a
new path, or click Change to browse for an existing folder.

Install TrackMaker61MK2 to:
C:\Program Files (x86)"Track Maker6 1MK2

Change...

Space required: 7.37 MB
Space available on selected drive: 242.35 GB

Cancel

Figure 1.5:  Select Installation Directory window

A default directory is C:\Program Files\TrackMaker61MK?2. Click the Next button to
install the program to this directory. If you wish to install the program to another direc-
tory, click the Change button, and the Select Installation Directory window will open.
Select a target directory and click OK. The Select Installation Directory window closes,
and the Installation Directory window opens with the selected directory listed. Click the
Next button. The Select Short cut Folder window opens (Figure 1.6).

B TrackMaker61MK2 Setup X

Where would you like the shortcuts to be installed?

The shortcut icons will be created in the folder indicated below. K you don't want to use the default
Folder, you can either type a new name, or select an existing folder from the list.

Shorteut Folder:
[Track MakerB 1MK2 -

() Install shortcuts for cument user only
(@) Make shortcuts available to all users

Cancel

Figure 1.6:  Select Shortcut Folder window

The setup program will create a TrackMaker61MK2 menu item in the Program menu ac-
cessible by clicking Start. If you do not want to use the proposed folder, you can either
enter a new name, or select an existing folder from the list. Click Next and the Ready to
Install window will follow (Figure 1.7).
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T TrackMaker51MK2 Setup

'_ fou are now ready to install Track Maker61MK2 V2.09

The ingtaller now has enough information to install TrackMakers1MK2 on your computer.

The following settings will be used:
Install folder: C:\Program Files (x86)"Track Makerb1MK2
Shorteut folder:  TrackMaker1MK2

Please click Mext to proceed with the installation.

| <Bax || ﬂaxt>kJ| Cencal |

Figure 1.7:  Ready to Install window
In case you would like to make any changes before the installation, click Back. To abort
installation click Cancel. If you are ready to start installation, click Finish. The instal-
lation progress bar will appear. The Installing Files window with a progress bar displays
the percentage of the installation completed. When finished, the following window will
appear (Figure 1.8).

Do TrackMaker61MK2 Setup

Installation Successful
The TrackMakerE1MK2 V2 09 installation is complete.

Thark you for choosing TrackMakerb1MK2!
Please click Finish to exit this installer

Please visit us at hitp //www geomar com

= Bech

Eencel

Figure 1.8: Installing Files

Click Finish to end installation. The SetupT61MK?2 creates a TrackMaker61MK2
program group and places TrackMaker61MK2 and Uninstall icons into it. The setup
program creates also a TrackMaker61MK2 menu item in the Program menu accessible
by clicking Start. A reminder to restart the system may be displayed at the end of the
setup program. The destination directory that was chosen earlier contains program files
and sample data files.

TrackMaker61MHK2 User’s Manual



1.4 Program Overview

Start the TrackMaker61MK?2 by double clicking the TrackMaker61MK?2 icon in the
Start | Programs menu, in Windows Explorer, or on the desktop if a shortcut was cre-
ated. At the start, TrackMaker61MK2 displays the following screen (Figure 1.9):

6 TrackMaker61MK2

File Position Readings Cenvert Data Files  Data Transfer  Help

processing Navd 1 MK2 data

q

Copyright © 2002-2021 Geomar Software Inc.

Figure 1.10: TrackMaker6IMK2 Main Screen

The TrackMaker61MK?2 is a menu driven program. Most of menus items are disabled till
a data file is loaded in to the program. A short description of the possible menu options
is given below.

File Menu

The File Menu is shown in Figure 1.10. Functions accessible from this menu allow you to
load data file, to save data set, to save data set under different file name (Save As), to re-
move loaded data from the program memory (Close), to edit data parameters, to display
two dimensional layout of selected XYZ file, and exit the program.

When program starts most of items in File menu are disabled. As soon as data file is se-
lected and data is loaded to the program memory the splash graphic disappears and the
program displays information related to data file contents, Figure 1.11. At the same time
remaining items in the File menu are enabled.
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64 TrackMaker61MK2

File Position Readings Convert Data Files Data Transfer Help
Open File
Save

Save As

Close processing Navé 1MK2 data

Edit Parameters
Display XYZ File

Exit

Copyright ® 2002-2021 Geomar Software Inc.

Figure 1.10: TrackMaker6IMK?2 File menu

64 TrackMaker61MK2

File Position Readings Convert Data Files  Data Transfer Help

200416_002.P61
Created on 16/04/2020

i Local [Logger) Time - GPS Time
Started:  23:05:39.902 Started:  03:32:10.43
Ended:  23:40:39.465 Ended:  04:07:02.43

i~ Data File Contents ————————————— [~ Data File Setlings
EME1-MK2 Readings 14728 EMET-MK2 Type:  Standard
GPS Positions: a03 Sensor Type: 1«05m
Irwalid GPS Data: 18 Distance Urits:  meters
Esternal Sensor Data: 0 GPS Message: GEA/GSA
Survey Lines: 1 GPS K Offset 1]
Camments: 1] GPS Y Offset 5
Mode 4 readings: 14728 Survey Mode: Auta
Mode D readings: 0 Ext.Sensor Type: MNone
Fiducial Markers: 0 GPS Elevation:  Available

Figure 1.11: TrackMaker61IMK2 Main Screen after Loading
data file

TrackMaker61MK2 does not allow to overwrite original data file. The Save option is
enabled only when not original data file (i.e. with edited parameters or previously Saved

TrackMaker61MHK2 User’s Manual



As) was loaded or after option Save As was used. When original data file is selected the
name of the file and date of the creation is displayed at the top of the screen. In case
when not original file was loaded then the current file name is displayed, followed by an

original date of creation and original file name, for example: "Created on 06/02/2003 as
060215A.P61".

The information displayed by the TrackMaker61MK?2 contains Local and UTC time,
number of EM61-MK?2 data points and GPS positions, specified distance units and GPS
antenna offsets, etc. (see Figure 1.11). Five parameters: EM61-MK2 Type, Sensor Size,
Distance Units, GPS X and Y offsets can be adjusted using the Edit Parameters item
(see Figure 1.12).

[l Edit MAVEIMK? File Param... — O e
Parameter Onginal from File Current Settings
Instrurment Type:  Standard Standard -
Sensar Size: 1.0=05m 1.0=05m ;I
Distance Units: meters meters vl
GPS ¥ Offset a 0

GPS ¥ Offset 5 [0

GPS offsets are measured in comezponding Distance Unitz

from Eile Cancel | (0] '\J
]

Figure 1.12: Edit Parameters window

Position Readings Menu

The Position Sensors menu represents the main function of the program: positioning
of the EM61-MK2 sensor based on the system geometry and GPS positioning (Figure
1.13).

The first item of the menu, Position Sensors using Nav61MK2 Data File allows you to
position sensors based on Real Time GPS data embedded in Nav61MK?2 file. Using GPS
data the program can also place elevation data in the output file.

The second item, Position Sensors using External GPS File is used to replace Real Time
GPS data by positions from the post-processed GPS data file. The later requires that the
GPS data is collected in the field computer running Nav61MK2 program as well as in
the separate GPS receiver logger. GPS data can be processed by the GPS manufacturer
software and then exported as an ASCII file. This option is especially useful in the fol-
lowing cases:

1.
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68 TrackMaker§1MK2 = X
File Position Readings Convert Data Files  Data Transfer  Help

Position Readings Using NAVE1ME2 Data Files

Position Readings Using External GPS File

Position Readings Using Geonics (.ME1) File

r~ Local [Lagger) Tir ~ GPS Tir
Started:  23:05:38.5902 Stated: 03321043
Ended:  23:40:33.465 Ended: 04070543

r— Data File Contents ——————————————— ~ Data File Settings
EMET-MEZ Readings 14728 EMET-MK2 Type: Standard
GPS Positions: 803 Sensor Type: 1%05m
Invalid GPS Data: 18 Distance Urits:  meters
External Senzor Data: 0 GPS Message: GGA/GSA
Survey Lines: 1 GPS ¥ Offsst: a
Camments: 0 GPSY Offsst 5
Mode 4 readings: 14728 Survey Mode: Auto
tode D readings: a Ext.Senzor Type:  Mone
Fiducial Markers: 0 GPS Elevation:  Available

Figure 1.13: TrackMaker61MK?2 Position Sensors menu
* when Real Time differentially corrected positioning is not available,

e accuracy of positioning may be further improved by processing data using
special GPS software,

e if special or unique coordinate system provided by GPS software is required
and it is not available in other employed data processing or mapping soft-
ware.

The third method allows you to position EM61-MK2 stations based on Real Time GPS
data which were recorded in Nav61MK?2 data file during the survey and then converted
and processed in Geonics program DAT61MK2. The DAT61MK2 has its own GPS Posi-
tioning option however it does not support NMEA messages other than GGA, filtering
for PDOP Mask, GPS Minimum Interval and GPS Antenna offsets.

Convert Data Files Menu

The Convert Data menu has four functions available. The menu is shown in Figure 1.14.

The first item, Nav61MK?2 Files to Geonics (M61) Format allows you to convert
Nav61MK?2 data files to files that can be loaded and processed by the Geonics DAT-
61MK2 program.

10
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|63 TrackMakers1MK2

File Position Readings = Convert Data Files  Data Transfer  Help
L\\: MNAVETMEK2 (PE1] Files to Geonics (ME1) Format
MNAVETMEKZ Files to ASCIl Format
Retrieve and Position Field Comments

GXY File to XY (ASCIl) Format

~ Local [Log .
Correct Time Constant Delay in XYZ File

Startec
Endec:  23:40:39.465 || Endec  oso7mess

r— Data File Contents ————————  ~ Diata File Settings
EMET-ME2Readings 14728 EMET-MK2 Type:  Standard
GPS Positions: 803 Sensor Type: 1%05m
Invalid GPS Data: 16 Distance Urits:  meters
External Sensor Data: 0 GPS Mezzage: GLEA/MGSA
Survey Lines: 1 GPS ¥ Offset: 1]
Comments: 0 GPS v Offset 5
Mode 4 readings: 14728 Survey Mode: Auto
Mode D readings: 0 Ext.Sensor Type:  Mone
Fiducial Markers: o GPS Elevation:  Available

Figure 1.14: TrackMaker61MK2 Convert Data menu

The second item, Nav61MK?2 Files to ASCII Format allows you to convert data files to
ASCII text format. This file can be simply used to examine data in text mode, or it can
be easily converted to other formats if required.

In case when the Nav61MK?2 program was used to acquire stand-alone GPS positions
(without EM data) the data files have extension name GXY. The third item, GXY File
to XY (ASCII) Format can be used to convert binary data file to simple text file with two
to four columns: Easting (Longitude), Northing (Latitude), and optionally Elevation
(including correction for GPS antenna height) and Time Stamp of the record. These
files can be used in other applications, i.e. in mapping software to denote topographical
features as roads, fences, etc.. This option can be also used to convert any Navo1MK2
data file to a text file containing coordinates and elevation of GPS positions.

The fourth item of the Convert menu, Retrieve and Position Field Comments allows you
to filter out and position field comments entered by the operator during the survey.

The last option of the Convert menu, Correct Time Constant Delay in XYZ Files can be
used to correct the effect of the system (combined EM61-MK2 and GPS receiver) time
constant delay in two dimensional XYZ files generated during positioning EM61-MK2
data.

1.
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Data Transfer Menu

This menu applies mainly to older field computers (DOS based handheld units, Win-
dows CE and Windows Mobile devices). All data files collected with Windows 7 or
Windows 10 computer can be copied and pasted using standard Windows procedures,
and move files between computers using USB drives or network connection. The menu
is shown in Figure 1.15.

64 TrackMakerf1MK2 - X
File Position Readings Convert Data Files = Data Transfer Help
Download Allegro DOS Files
20 Download Logger Data Files ‘

Created on 16/04/2020

i~ Local [Lagger) Time - GPS Time
Started:  23:05:39.902 Stated: 03321043
Ended:  23:40:39.465 Ended: 04:07:08.43
r Data File Contents ——————————————  ~ Data File Settings
ERET-4KZ Readings 14728 EMET-MKZ Type: Standard
GPS Positions: a03 Sensor Type: 1x05m
Invalid GPS Data: 16 Distance Units:  meters
External Senzor Data: 0 GPS Message: GGA/GSA
Survey Lines: 1 GPS ¥ Offset: a
Comments: u] GPS Y Offset 5
Mode 4 readings: 14728 Survey Mode: Auto
tode D readings: a Ext.Sensor Type: Mone
Fiducial Markers: 0 GPS Elevation:  Awvailable

Figure 1.15: TrackMaker61MK?2 Data Transfer menu

This menu has two items: Download Allegro DOS Files and Download Logger Data
Files. The legacy Download Allegro DOS Files option is still available in TrackMak-
er61MK?2 code, however it is not supported. It is over 20 years old technology and it may
be difficult or simply impossible to use it with current Windows versions and available
hardware. The procedure is described in detail in previous version of manual: Track-
Maker61MK2 V152.pdf, chapter 2. In case DOS based field computer is used to collect
data it is strongly advised to PC memory card to transfer data files between field and
desktop computers.

The second item Download Logger Data Files applies to transfer of files from Allegro
CX (Windows CE.NET) and Windows Mobile field computers. It is handled by the MS
ActiveSync program. Therefore the second item of this menu displays information only
(Figure 1.16).

12
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TrackMakert 1 MK2

Please use M5 ActiveSync or memory card to transfer data files
from Windows CE or Windows Maobile device

Figure 1.16: Windows CE and Windows Mobile data
transfer info

Optionally, data files and program files can be transferred between Allegro (Windows
CE as well as DOS based units) by using PC memory card. A PCMCIA card slot is
located behind the Allegro display (please see Allegro manual). Memory card becomes
drive D: as soon as it is inserted to Allegro DOS and it is recognized as a Storage Card
in Allegro CX. Memory card is the fastest and easiest way of performing data transfer
between Allegro and PC computer. In addition to data transfer, memory card can serve
as a data back up device during the survey.

Downloading files from DOS based Allegro is performed with the cooperation of the
field computer program (option Dump Files). Alternatively, data files created in DOS
based loggers can be transferred from the field computer by the Juniper System program
Lynx which is available with Pro4000 and Allegro loggers.

64 TrackMakers1MK2

File Position Readings Convert Data Files  Data Transfer I}}:ielp

About
200416_002.P6T

Created on 16/04/2020

r~ Local [Logger) Time ~ GPS Time
Started:  23:05:39.502 Stated:  03:3210.43
Ended:  23:40:39.465 Ended: 04070242
 Data File Contents ———————————— [~ Data File Settings
EMET-MKZ Readings 14728 EMET-MKZ Type:  Standard
GPS Paositions: 203 Senzor Tupe: T«05m
Irevalid GPS Data: 16 Distance Units: ~ meters
Extenal Sensor Data: 0 GPS tMessage: GGEA/GSA
Survey Lines: 1 GPS < Offset: 0
Carnrments: 1] GPS Y Offset 5
taode 4 1zadings: 14728 Survey Mode: Auto
Maode [ readings: 0 Ext.Sensor Type: Mone
Fiducial Markers: 0 GPS Elevation:  Avaiable

Figure 1.17: TrackMaker61MK2 Help menu
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Help Menu

Item "About" is the only available option in this menu (Figure 1.17). It displays name
and version of the program. Help function is not available in this version of the Track-
Maker61MK2.

8 TrackMakersMK2 - x

File Position Readings Convert Data Files  Data Transfer  Help

200416_002.P61

Created on 16/04/2020

£ 6¢ About TrackMaker§1MK2

~DataFi
-1 TrackMaker61MK2
GPY
- Version 2.09
Exte A
3 Geomar Software Inc.
Con
hag
Mode D readings: 0 Ext.Sensor Type:  Mone
Fiducial Markers: 0 GPS Elevation:  Awailable

Figure 1.18: TrackMaker61MK?2 version info

A detailed description of the function of each menus item is provided in relevant sections of the
manual.

14 TrackMaker61MHK2 User’'s Manual



File Menu

File menu of TrackMaker61MK2 program is shown in Figure 2.1. There are several items associ-
ated with the File menu:

*  Open File (loads NAV61MK?2 data file to the program memory),

» Save (saves data to the same file, disabled if original data file loaded),
* Save As (saves data to a file with different file name),

* Close (closes current data set),

* Edit Parameters (changes parameters in loaded data set),

* Display XYZ File (displays layout of stations in XYZ file),

* Exit (terminates TrackMaker61MK2 program).

68 TrackMakers1MK2

File Position Readings Convert Data Files  Data Transfer Help
Open File

% Save

Save As

Close processing Navé 1MK2 data

Edit Parameters
Display XYZ File

Exit

K2

Copyright © 2002-2021 Geomar Software Inc.

Figure 2.1:  TrackMaker6IMK?2 File menu

When program starts most of items in the File menu are disabled. They are enabled
automatically as soon as data file is loaded in to the program memory.

The general rule of the TrackMaker61MK?2 software is that the program cannot over-
write original file name. In order to Save file, the original file name must be "Saved As"
first. The program tags such file and menu item Save is enabled. At further runnings
when the "Saved As" file will be loaded item Save will be enabled automatically.
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2.1 Open File

The Open File option allows you to load NAV61MK?2 data file to the program memory.
Select File | Open File from the main program menu, as shown in Figure 2.1. After the
selected menu item is clicked the Select NAV61MK2 Input File window will be displayed
in the centre of the screen, Figure 2.2.

64 Select NAVEIMK2 Input File X

4 [ |» ThisPC > Windows(C) » Data > Tm61MK2 > SRD_Site v @ O SearchSRDSite
Organize »  New folder e T @
GeomarFile A Name Dste modified Trpe Size
Graphicsimages 51 060710A.P61 P61 File 323 KB
Gtem_Data [E] 200414_000.P51 P61 File 15KB
inetpub [ 200412 001 P61 P61 File 6KB
Intel [l 200415 000.P61 P&1 File s2K8
MyDocuments g 200415_001.P61 P51 File 86 KB
bertogs 3 aoae_ooopen P61 File 25K8
o =] 200416_001.P61 P61 File 30KB
ote 1 200415_002.P61 P61 File 1,230KB
Program Files | 200417_000.P51 P61 File 18
Program Files (x86) [Z 200417_001.p61 P61 File 597 KB
ProgramData 5] 200417_002.961 P61 File 113 K8
ProgramsGeomar [ 200417_003.P61 P&1 File 208 K8
ProgramsGeanics \:‘zmmnpm P51 File 534K8
publications 1 ar00s.ps1 P51 File 540 K8
Temp v
File name: [200415_002 P51 | [NAVEIMK Files (P61 p51)

Figure 2.2:  Select NAV61MK?2 Input File window

The window lists files with extension name P61. Select a file name and click the Open
button. The Select NAV61MK?2 File window will close and the progress bar will appear
in the center of program’s main window indicating percentage of loaded file (Figure 2.3).

As soon as data file is selected and data is loaded to the program memory the splash
graphic disappears and the program displays information related to data file contents. At
the same time remaining items in the File menu (and items in other menus as well) are
enabled and the Open File item is disabled.

The TrackMaker61MK2 main window displays the most important parameters of the
entered data file (Figure 2.4). At the top of the window the current file name, date of
file and optionally original file name (as entered in the field), and start and end times

in local time (field computer clock) and UTC time (GPS time in NMEA messages) are
displayed. Below, in the left window frame labeled Data File Contents a total number
of EM61-MK2 readings, number of GPS positions recorded, number of invalid GPS
positions (with not valid checksum), number of survey lines, comments, and number of
used fiducial markers in the field are given. In the right frame labeled Data File Settings
listed are: the EM61-MK?2 instrument Type, Sensor Size, type of used GPS NMEA mes-
sage, GPS X and Y offsets (in Distance Units), and survey mode.
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6 TrackMakers1MK2

File Position Readings Convert Data Files Data Transfer Help

processing Navé 1MK2 data

( 4

Copyright © 2002-2021 Geomnar Software Inc.

Checking GPS Positions Integrity. .

Figure 2.3:  Progress bar indicating loading NAV61MK? file
When original data file is selected the name of the file and date of the creation is dis-
played at the top of the screen. In case when not original file was loaded then the current

64 TrackMaker61MK2

File Position Readings Convert Data Files  Data Transfer  Help

200416_002.P61
Created on 16/04/2020

r~ Local [Lagger) Tim ~ GPS Tim
Started:  23:05:39.902 Started:  0332:10.43
Ended  23:40:39.465 Ended:  04:07:02.43
DataFile Cantents———————— [~ Data File Settings
EME1-MK2 Readings 14728 EME1-+K2 Type:  Standard
GPS Positions: 803 Sensor Type: 1%05m
Irevalid GPS Data: 16 Distance Units:  meters
External Sensar Data: 0 GPS Messzage: GEAMGSA
Survey Lines: 1 GPS 3 Offset: 1]
Comments: 1] GPS Y Offset Rl
Maode 4 readings: 14728 Survey Mode: Autg
Made D readings: 0 Ext.Sensor Type:  None
Fiducial Markers: 0 GPS Elevation:  Available

Figure 2.4:  TrackMaker61MK2 Main Screen after data file is
loaded
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file name is displayed, followed by an original date of creation and original file name, for
example: "Created on 16/04/2020 as 200416_002.P61", (see Figure 2.5).

At this point loaded data can be used for further data processing.

2.2 Save, Save As, Close

As it was mentioned data can be saved only if the data file was previously Saved As. This
assures that the original data file will not be overwritten, i.e. with edited parameters. The
File menu item Save is enabled only when other than original data file is loaded. The
indication that file was previously Saved As is given at the top of the screen, under cur-
rently loaded file name label "Created on 16/04/2020 as 200416_002" provides informa-
tion that the original file name was 200416_002.P61 (Figure 2.5). Otherwise this label
would provide only date of the created file (see Figure 2.6).

6 TrackMakers1MK2 = pd
File Position Readings Convert Data Files  Data Transfer Help
Open File
Save N Mod_200416_002.P61
S Created on 16/04/2020 as 200416_002
Close
) ~ GPS Tim
Edit Parameters 05:39.902 Started: 03321043
Display XYZ File 40:33 465 Ended: 04:07:02.43
Exit r~ Data Filz Settings
EMET-MFE.2 Readings 14728 EME1-ME2 Type: Standard
GPS Positions: 803 Sensor Type: 1#05m
Irvalid GRS Data: 16 Distance Units: ~ meters
Estemnal Sensar Data: 0 GPS Meszage: GLAGSA
Survey Lines: 1 GPS  Offset: 1]
Comments: 0 GPS * Offset A
tode 4 readings: 14728 Survey Mode: Avta
Mode D readings: 0 Ext.Sensor Type: Mone
Fiducial Markers: 0 GPS Elevation:  Awailable

Figure 2.5:  TrackMaker61MK2 Main Screen with item Save
enabled after not original file was loaded

The File menu item labeled Save As allows you to save any data set. Select File | Save As
from the program main menu (see Figure 2.6). After the selected menu item is clicked,
the Save As NAV61MK2 Input File window will be displayed in the centre of the screen,
Figure 2.7.
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6 TrackMaker61MK2

File Position Readings Convert Data Files  Data Transfer Help

Open File

Save 200416_002.P61

seEfe Created on 16/04/2020

Close

) ~ GPS Tim

Edit Parameters 05:39.902 Started: 03321043

Display XVZ File 40:39.465 Ended:  04:07:08.43

Exit - Data File Settings
EMET-MEZ Readings 14728 EME1ME2 Type: Standard
GPS Positions: 803 Sensor Type: 1#05m
Irvalid GPS Data: 16 Distance Units:  meters
Estemnal Sensar Data: 0 GPS Meszage: GLAGSA
Survey Lines: 1 GPS x Offset: 1]
Comments: 0 GPS Y Offset 5
Mode 4 readings: 14728 Survey Mode: Avta
Mode D readings: 0 ExtSensor Tupe: Mone
Fiducial Markers: 0 GPS Elevation:  Available

Figure 2.6:  TrackMaker61MK?2 Screen with loaded original data
file, disabled Save option, and selected Save As item

This option is especially useful when working with data files created in hand held de-
vices. Data files created in Windows OS (especially Windows CE or Windows Mobile)

64 Save As NAVGTMKZ Input File X

A > ThisPC » Windows (C) » Data » TrmGIMK2 > SRD Site v o 2 Search SRD Site
Organize v New folder fzz - (-]
A Name Date modified Tpe Size @
# Quick access
2 0607108561 2 P51 File 323KB
OneDrive (=] 200414_000.P61 2 P61 File 15K8
= s pe !;:,‘zoom 001,61 2 P61 File 6KE
[ 200415_000.P61 2 P51 File L2Kk8
3D Objects
2 P61 File 86 KE
I Desktop 2 P61 File 25Ke
Documents 2 P61 File 30Ke
& Downloads 2 P61 File 1,230K8
D Music 2 P61 File 1KB
&) Pictures 2 P51 File 59TKB
B Videos 2 P61 File 113Ke
2 P61 File 208KE
iy Windows (C) iy
2 P51 File 634KB
- @ - - . 2
File name: | Mod 00416_002.P51 =
Save as type: | NAVGTMK2 Files (*P61,%p61) -
e e

Figure 2.7: Save As NAV6IMK?2 Input File window

may contain records that are not organized according to time stamp sequence. When
such file is loaded, first it is sorted by the program. The option Save As will save data in
organized format, and therefore loading previously saved file will be faster (since sorting
is not necessary). The program recognizes sorted files automatically.
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2.3

After the file is saved with Saved As option the Main Screen of TrackMaker61MK2 will
be updated, and file name will placed at the top of the screen and the item Save in the
File menu will be enabled, Figure 2.8 (compare with Figure 2.6).

68 TrackMaker61MK2

File Position Readings Convert Data Files Data Transfer Help

Mod_200416_002.P61
Created on 16/04/2020 as 200416_002 L\\,

— X

~ GPS Tim

r~ Local [Lagger) Tim
Started:  23:05:39.902
Ended  23:40:39.465

Started:  0332:10.43
Ended:  0407.02.42

r Data File Contents

EMET-MK2 Readings
GPS Positions:
Irevalid GPS Data:
External Sensor Data
Survey Lines:
Comments:

tode 4 readings:
Maode D readings:

Fiducial Markers:

r~ Drata File Settings

EMET$KE Type: Standard
Sensor Type: 1%05m
Distance Units:  meters
GPS Meszage: GGA/MGSA
GPS ¥ Offset: 0

GPS Y Offset A

Survey Mode: Auto
Ext.Sensor Type: Mone
GPS Elevation:  Available

Figure 2.8: TrackMaker61MK2 Main Screen after completed

Save As opt

ion

Clicking on the Close item in File menu will remove data set from the program memory,
the Main Screen will display splash graphic and the menu item Open File will be en-
abled. This action allows you to load another NAV61MK2 data file.

Edit Parameters

Four parameters entered during the field work can be modified during data processing.
Click on the Edit Parameters item in the File menu and the Edit NAV61MK2 File Pa-
rameters window will appear (Figure 2.9). The Edit Parameters window is also available

in Position Readings options.

The window displays parameters that the user can edit. These are: EM61-MK2 Type,
Sensor Size, Distance Units, and GPS X and Y offsets. If all parameters were correctly
specified in the field then clicking on OK or Cancel button will accept these entries. In
case some of the parameters require modification they can be entered in appropriate
text boxes located under label Current Settings. Sensor Size and Distance Units can
be selected from combo list boxes, while GPS X and GPS Y offsets must be entered in
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[ Edit NAVE1MEKZ File Param... — O

Parameter Original fror File  Current Settings

Inztrument Type:  Standard Standard vl
Senzor Size: 10x05m -1.UHD.5ITI 'I

Digtanice Urits: meters meters i!
GPS ¥ Offzet 1]

0

GPS ' Offset R I A

GPS offzets are measured in coresponding Distance Units

frarn Eile Cancel |

Figure 2.9: Edit NAV6IMK?2 File Parameters
window

appropriate text boxes. Example of NAV61MK?2 File Info window with modified param-
eters is shown in Figure 2.10.

[ Edit NAVE1MEK2 File Param... — O

Parameter Original fror File  Current Settings

Ingtrument Tepe:  Standard Standard - I
Senzor Size: 10x05m [1.0005m 'I
Digtance Units: meters meters vl

GPS ¥ Offset o 05

GPS ' Offset A IEI.?'E]

GPS offzets are measured in corezponding Distance Units

frDmEiIel Cancel | [8]4 L\\i

Figure 2.10: Modified parameters in Edit
Parameters window

Clicking on the OK button will accept any changes, clicking on the Cancel button will
cause the program to use initial parameters (state when window was displayed), while
clicking on the button from File will change parameters to original values (listed in fields
under label Original from File). After the buttons OK, Cancel or from File are clicked
the Edit NAV61MK?2 File Parameter will disappear.

2. File Menu 2]



Any updates in this window are valid only for duration of the program. The data file will
remain the same unless it Saved or Saved As in File menu.

2.4 Display XYZ File

The Display XYZ File option allows you to display two dimensional layout of stations
in a selected XYZ file. Select File| Display XYZ File from the main program menu, as
shown in Figure 2.1. The Select XYZ to Open window will appear.

The window lists files with extension name XYZ. Select a file name and click the Open
button. The Select XYZ to Open window will close, the file will be loaded and two di-
mensional image will be displayed (Figure 2.11).

The image displayed in the Plot XYZ window shows the spatial layout of stations to
scale, based on the station coordinates as written in the selected XYZ file.

Figure 2.11: Two dimensional layout of stations in XYZ File
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Position Readings

Positioning of the Geonics EM61-MK2 is the main function of the TrackMaker61MK2. Location
of the electromagnetic sensor is calculated based on the recorded GPS position, instant heading
of the system, and the system geometry which is described by the location of GPS antenna.

There are three methods of positioning sensors in TrackMaker61MK?2: Position Sensors using
NAV61MK2 Data File, Position Sensors using External GPS File, and Position Sensors using
Geonics (M61) File. The first method allows you to position sensors based on Real Time GPS
data embedded in NAV61MK?2 file while in the second technique Real Time GPS data are re-
placed by GPS positions from the post-processed GPS data file. The second method requires that
the GPS data is collected in the field computer running NAV61MK2 program as well as in the
GPS receiver logger. This option is especially useful in following cases:
e when real time differential data correction is not available,
* accuracy of positioning may be further improved by processing data using special
GPS software,
¢ if a special or unique coordinate system provided by GPS software is required and it
is not available in other employed data processing or mapping software.
The third method allows you to position EM61-MK2 stations based on Real Time GPS data
which were recorded in NAV61MK?2 data file during the survey and then converted and pro-
cessed in Geonics program DAT61MK2. The DAT61MK?2 has its own GPS Positioning option
however it does not support NMEA messages other than GGA, filtering for PDOP Mask, GPS
Minimum Interval and GPS Antenna offsets.

Description of functions involved in positioning the EM61-MK2 is preceded by a short descrip-
tion of the system geometry.

3.1 The NAV61MK2 System Geometry

The GPS antenna can be placed anywhere in relation to the instrument center. However
to achieve the highest possible accuracy of the calculated positions the GPS antenna
must be placed as close to the center of the system as possible. The best and optimal
placement of the GPS antenna is located above the center of the EM61-MK2 sensor.

When a survey is positioned by GPS system and GPS antenna can not be placed in the
center point of the instrument the program allows to specify the GPS antenna offset
from the EM61-MK?2 sensor center. Two parameters, GPS X Offset and GPS Y Offset
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describe location of GPS antenna. This location is represented by the distance which is
measured from the center of the EM61-MK2 antenna to the center of the GPS antenna,
while facing direction of the movement, see Figure 3.1.

k<]
()
£
[
3
€
GPS Xoffset ° System Y axis
.§
B System X axis
GPS Antenna
(&)
GPS Yoffset - ” E]
) ' EM61-MK2
System Reference Point (0, 0) Sensor

Figure 3.1: The EM61-MK2 and GPS antenna geometry

The procedure of specifying X and Y offsets in relation to the direction of the system
movement is very important and should be maintained during data collection for the en-
tire data file. Therefore, the operator can not walk few steps or drive backwards without
changing data file name. If it is necessary data logging must be paused for the time of
such movement since positioning of the sensor based on GPS is based on this assump-
tion.

This option is provided mainly for situations where the operator pushes or tows the
EM61-MK?2, and GPS antenna (placed in backpack) is located above his shoulder. In
this case distance between GPS antenna and the instrument (GPS X Offset) is small,
and GPS Y Offset will be usually larger and its sign will depend on pushing or towing.
This situation corresponds to the system geometry presented in Figure 3.1. Another case
that offsets have to be used is when longer cable from GPS receiver to GPS antenna is
unavailable.

The offset in Y direction (GPS Y Offset) can be used if the instrument is towed and the
GPS antenna is located on the same trailer or on the towing vehicle (Figure 3.2). It is
always advised to make the GPS Y offset as small as possible to achieve better position-
ing accuracy. The TrackMaker61MK?2 calculates positions using advanced interpolation
based on time stamps, neighouring GPS positions, as well as projected EM61-MK2 posi-
tions along curved paths to achieve positioning as accurate as possible. However, as it
was mentioned earlier, the highest accuracy is achieved when the GPS antenna is located
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Figure 3.2:  Geometry of the EM61-MK?2 sensor and GPS
antenna during towing

above the center of the EM61-MK2 sensor. In case where the GPS antenna is located in
front of the electromagnetic sensor the GPS Y Offset is positive, and if the GPS antenna
is located behind the instrument the GPS Y Offset is negative.

In the case where a wrong value was entered in the field, GPS X Offset and GPS' Y
Offset parameters can be corrected later during data processing in the program Track-
Maker61MK2.

In general, when GPS antenna is located off the center of the system positions of the
instrument will be calculated based on the GPS antenna position and instant heading. In
order to achieve higher quality of data positioning the survey should be carried out along
relatively smooth pathways, especially if GPS antenna is located further from the center
of the instrument.

When the direction of the survey line is changed it is advised to pause recording of data
for the duration of U-turn. Toggling between Stand By mode (pause) and Log mode is
relatively easy in the most difficult field conditions, it is done by one key stroke (Pause
and Start keys), and it can save time during data processing.

Similar approach applies to situations when the system is stopped. In this case if readings
are not paused, the random distribution of small GPS errors will likely result in unreli-
able locations of calculated sensor positions. If the offset of GPS antenna is used it may
appear that the instrument is rotating since GPS errors occur in many directions. Paus-
ing readings while the system is stopped will save time during data processing and will
result in better data presentation.
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3.2 Positioning Readings Using NAV61MK?2 Data File

After a data file is loaded the TrackMaker61MK2 main window displays the most im-
portant parameters of the entered data file (Figure 3.3). At the top of the window the
current file name, date of file and optionally original file name (as entered in the field),
and start and end times in local time (field computer clock) and UTC time (GPS time
in NMEA messages) are displayed. Below, in the left window frame labeled Data File
Contents a total number of EM61-MK2 readings, number of GPS positions recorded,
number of invalid GPS positions (with not valid checksum), number of survey lines,
comments, number of readings in mode 4 and D, and number of used fiducial markers
in the field are given. In the right frame labeled Data File Settings listed are: type of the
instrument, Sensor Size, type of used GPS NMEA message, GPS X and Y offsets (in

Distance Unitsi, and survei mode.

File =Position Readings Convert Data Files Data Transfer Help
Position Readings Using NAVGTMK2 Data Files
Position Readings Using External GPS File L\\’
Position Readings Using Geonics (.M61) File 6 002

r~ Local [Logger] Time ~ GPS Time
Started:  23:05:39.902 Stared: 03321043
Ended:  23:40:33.465 Ended: 04:07:08.43

r Data File Contents————————  ~ Data File Settings
EMET-MEZ2 Readings 14728 EMBT-MEZ2 Type:  Standard
GPS Pasitions: 803 Senszor Typpe: 1w06m
Irvealid GPS Data: 0 Distance Uit~ meters
External Sensor Data: 0 GPS Message: GEA/GSA
Survey Lines: 1 GPS ¥ Offset ]
Camiments: 1] GPS % Offset 5
Mode 4 readings: 14728 Survey Mode Auto
Mode D' readings: 0 Ext Senzor Type: Mone
Fiducial Markers: 0 GPS Elevation:  Available

Figure 3.3:  Position Readings menu

The Position Readings Using NAV61MK?2 Data option allows you to position EM61-
MK?2 stations based on Real Time GPS data which were recorded in NAV61MK?2 data
file during the survey. Select Position Sensors | Position Readings Using NAV61MK?2
Data Files from the main program menu, as shown in Figure 3.3.

After the selected menu item is clicked the Position EM61-MK2 Readings Using
NAV61MK?2 Data File window will be displayed in the centre of the screen, Figure 3.4.
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Parameters in Positioning Readings Using NAV61MK2 Data File Window

Several parameters which affect the contents and format of the created output (XYZ)
file must be specified. These are the XYZ output file name, parameters describing con-
tents and format of the created file and parameters related to electromagnetic as well as

to GPS data.

Edit Parameters | Fieplot Lazt Output File

DD Position EMGTME2 Reading Using NAVETME2 File

Qutput 52 File |

Type of Output File
IV ¥ Generic ' Geosoft

& Linear

|' Select Amplitude Scale

" Compressed

Format [Column Delimiter)
‘ IV @ Fined [Spaces) [ =1t

" Geodstic

& LUTH

— Output Coordinates MwGS584)

— Format
& DDD.ODDDDDDD
£ DDDMM. MR

r~ Unit

IM eters - I

— Select EMET-MK2 Channels
W Chl ¥ Ch2 | Ch3 |¥ Chd

| Standard 4 (STD-4) |

—5Select Optional Data————————————————
[” Elevaton W GPSOC ¥ Time

Arterna Height ID.DD & m R

— Time uzed during sensors positioning

I~ Use UTC time for uniform distribution [recommended for EMET-MK2 update rate > 5 Hz)

—GPS Time Gap —GPS Minimum Interval —— — GSA Message Include in File
el et - g =
~PODOP Mask  Corrections — Position Mode
Iﬁ GGA/GSS W @ valid only for Proceed
¥ Pasitive Only 20 GGA/GSA
|
LCancel E xit

Figure 3.4:  Position EM61-MK?2 Readings Using NAV61MK?2

Edit Parameters

Data File window

The TrackMaker61MK2 main window (Figure 3.3) displays the most important

parameters of the entered data file. In case some parameters were wrongly

entered in the field it is possible to change them using Edit Parameters option
(the same option is available in the File menu of the TrackMaker61MK2 main
screen). Click on the Edit Parameters button and Edit NAV61MK?2 File Param-
eters window will appear (Figure 3.5).
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Dutput 252 File

Edit Parameters |

Select Amplitude Scale

Type of Output File
(* Generic .

Format [Column D elimiter]

Geosoft

[+0 Geasgcsa

Differential [DGPS]

¥ Positive Only

* 30 valid only for
20 GGASGSA

* Linear " Caompressed * Fized [Spaces L5
[ Edit NAVE1MK? File Param...
Output Coordina s —
e i i Ch3 [» Chd
£ Geodetic Parameter Ornginal from File  Current Settings
Instrument Type:  Standard Standard - =
& UTM Sensor Size: 1.0x05m  [1ox05m -] [
Digtance Units: meters meters - AC W Time
GPS X Offsat ] 0 | &m
Time used during EiFS Y Oifis=! 5 3 —
[~ UseUTCt GPS offsets are measured in correzponding Distance Units > 5 Hz)
GPS Time Gap—| fram File | Cancel | & in File
|—5 sect eader Info
T T Teet I [T Field Comments
PDOF Mask Canrections Position Mode

=

LCancel ‘ Ezit ‘

Figure 3.5: Edit NAV61MK?2 File Parameters window

The window displays parameters that the user can edit. These are: the EM61-
MK?2 type, Sensor Size, Distance Units and GPS X and Y offsets. If all param-
eters were correctly specified in the field then clicking on OK or Cancel button
will accept these entries. In case some of the parameters require modification
they can be entered in appropriate text boxes located under label Current
Settings. EM61-MK2 Type, Sensor Size and Distance Units parameters can be
selected from combo list boxes, while GPS X and GPS Y offsets must be en-
tered in appropriate text boxes. Example of NAV61MK?2 File Info window with
modified parameters is shown in Figure 3.6.

Clicking on the OK button will accept any changes in parameters, clicking on
the Cancel button will cause the program to use initial parameters (state when
window was displayed), while clicking on the button from File will change
parameters to original values (listed in fields under label Original from File).
After the buttons OK, Cancel or from File are clicked the Edit NAV61MK?2 File
Parameter will disappear.
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[ Edit NAVE1MK2 File Param...  — O

Parameter Original from File  Current Settings
Instrument Type:  Standard Stardard hd
Senzar Size: 1.0x05m 1.0%05m LI
Distance Units: meters m
GPS 5 Offset 0 [od
GPS ¥ Difset 5 foos

GPS offsets are measured in coresponding Distance Units

from Eile | Cancel | (8] %J

Figure 3.6:  Modified parameters in Edit
Parameters window

Any updates in this window are valid only for duration of the program. The data
file will remain the same unless it Saved or Saved As in File menu.

Output File

Click on the Output XYZ File button. The Select Output File window is dis-
played (Figure 3.7).

Select a file name and click the Save button. The Select XYZ File window will
close and the selected file name will be displayed beside the Output XYZ File
button in the Position EM61-MK2 Readings Using NAV61MK?2 File window.

[T Select Output File X

4[| « Windows (C) > Data 5> Tm&IMK2 > SRDSite v o 2 Search SRD_Site
Organize ~ New folder B== - (]
A Name Date modified Type Size
7t Quick access "
] 200414_metersxyz XYZ File 2KB
OneDrive 7 200414 _meters GPSxyz X¥Z File 3KB
E 6
B This PC ”j CO01_geodeticaxyz XYZ File 1,668 KB
T 1) C001_geodetic_GPSax XYZ File 40KB
¥ 30 Objects - g e )
| CO01_UTMmuxyz XYZ File 1,668 KB
I Desktop ] CO01_UTMm_GPSxyz XVZ File 40KB
Documents
4 Downloads
B Music
[&=] Pictures
B videos
i, Windows (C:)
File name: [ 200414 shayz -
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Figure 3.7:  Select Output File window

When Output file is specified the Proceed button in the Position EM61-MK2
Readings Using NAV61MK?2 File becomes active (Figure 3.8).
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Select EM61-MK2 Channels

To select a data type (component and dipole mode) click on desired check
buttons labeled Chl, Ch2, Ch3, Ch4 or ChT, ChD, and ChN. Data is always
placed in the created XYZ file in the following order: X coordinate (Easting or
Longitude), Y coordinate (Northing or Latitude), and Ch1, Ch2 through ChD.
This data may be followed by a column containing Time Stamp (this optional
parameter is located in a section Select Amplitude Scale).

If during data collection more than one instrument mode was used then select
Instrument Mode to be used during the creation of XYZ file in the combo list
box located below selection of EM61-MK2 channels. Change of the EM61-MK2
mode may change selection of available channels.

If parameter Header Info in Include in File section is checked a line listing all
parameters in the file will be placed as a header for each created XYZ file.

Select Amplitude Scale

Readings can be written in the output file in Linear (original) scale, or Com-
pressed, as the signed square root of each value. Check the appropriate radio
button in the Select Amplitude Scale section.

Select Optional Data

Three optional data can be written in the output file. These are Elevation, GPS
QC, and Time Stamp for each reading. To select optional data click on the
check box next to the corresponding name.

If the check box labeled Elevation is clicked (checked) then a text box labeled
Antenna Height and two radio buttons labeled m and ft become active. The

text box labeled Antenna Height allows you to enter correction for Elevation
data. The Antenna Height corresponds to the distance between ground surface
and GPS antenna. If Antenna Height is set to zero then elevations for the GPS
antenna (not the ground surface) are written to the output file. Two radio but-
tons labeled m (meters) and ft (feet) allows you to specify units for elevation
data placed in the output file. It is assumed that Antenna Height parameter is
entered in units specified by these radio buttons.

Elevation values base on the recorded GPS data. Therefore Elevations will not
be written to the file if the NMEA message GLL (it does not contain elevation
data) was used during the survey.

When the check box labeled GPS QC is checked the file will contain GPS signal
quality parameters: correction quality indicator (AGPS, DGPS, RTK, etc.),
PDOP or HDOP (depending on NMEA statement), and number of satellites
used to calculate position.

In case RTS SLAM pseudo-GGA messages were used during data collection the
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Figure 3.8:  Position EM61-MK2 Readings Using NAV6IMK2
Data File window

GPS QC option will be replaced by a check box labeled SLAM, when available
and checked the created file will contain four RTS SLAM parameters: SLAM
Confidence, Pitch, Rolol, and Yaw.

If check box labeled Time is checked then XYZ will contain local time and data
points will be interpolated between GPS points based on local time stamps. This
parameter can be overwritten by UTC Time option, described below.

Data is always placed in the created XYZ file in the following order: X coordi-
nate (Easting or Longitude), Y coordinate (Northing or Latitude), EM61-MK2
channels (as selected, 1 or 6 columns), Elevation, three GPS QC parameters
(Quality Indicator, PDOP or equivalent, Number of Satellites), and Time
Stamp.

If parameter Header Info in Include in File section is checked a line listing all
parameters in the file will be placed as a header for each created XYZ file.
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Use UTC Time for Uniform Distribution

When this option is checked EM61-MK2 sensor readings time stamps will be
replaced by uniformly distributed time stamps based on UTC recorded in neigh-
bouring GPS positions. At the same time, if option Time (indicated in Select
Optional Data section) is enabled time stamps in created XYZ file will contain
UTC time.

This option can be used when UTC time in XYZ files is needed or if very uni-
form data spacing is required. Windows timer has limited resolution and at high
rates (above 5 Hz) data can be not spaced very uniformly by Windows timer.

Type of Output File

Check the option appropriate for the contouring software used. The Generic
option will create a four or more column file without any text strings. This file
can be used as an input file for many contouring packages (including Surfer).
Geosoft format will cause the program to write LINE # at the beginning of each
survey line.

Format (Column Delimiter)

Check an option labeled Fixed or CSV appropriate for the mapping or other
software used. The Fixed (Spaces) will format aligned columns spaced by a
number of spaces. The CSV (Comma Separated Values) will divide columns
by a single comma. The latter format is also suitable to be used with Excel and
other programs.

Include in File

This section contains two check boxes labeled Header Info and Field Com-
ments. When Header Info box is checked the file will contain a header listing
type of coordinates and names of data contained in each column of created
XYZ file. Checking box labeled Field Comments will cause the program to
write text of all field comment (entered by the operator during the survey) in to
the created file.

Output Coordinates

Positions can be written in the output file as geodetic (geographical) coordinates
(Latitude/Longitude) or they can be converted to UTM coordinates. The pro-
gram uses the WGS1984 datum. To select coordinates click Geodetic or UTM
radio buttons (Figure 3.9).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can be
written in two formats DD.DDDDDDDD or DDMM.MMMMM (native for-
mat found in NMEA GPS messages). To select which format click the appropri-
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Figure 3.9:  Position EM61-MK2 Readings Using NAV61MK?2
Data File window

ate radio button in Format section located at the radio button labeled Geodetic.
This section is active only when radio button Geodetic is selected (Figure 3.9).

UTM coordinates can be generated in meters, feet, or US Survey feet. To select
units for UTM coordinates select proper parameter from the combo box located
in the Units section located at the UTM radio button (Figure 3.9). This combo
box is active only when radio button labeled UTM is selected.

GPS Time Gap

Differentially corrected GPS data often has gaps, due to differences in the con-
stellation of satellites visible to two (fixed and moving receivers), lack of beacon
signal, surveying near trees, buildings, and other elevated obstructions. These
gaps are filled by TrackMaker61MK?2 with the assumption that the GPS receiver
speed is essentially constant and that it moves along a straight line during the
gaps.
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The GPS Time Gap parameter specifies the maximum time during which the
EM61-MK?2 data will be linearly interpolated between two GPS positions. Enter
this parameter (in seconds) in the edit box labeled seconds in the GPS Time
Gap section (Figure 3.9). In most cases a value 2 to 3 times larger than the GPS
data acquisition frequency is adequate, however the user has to determine this
value based on the survey specific conditions and requirements. To ignore effect
of this parameter enter a large number of seconds (i.e. 300 or more) as GPS
Time Gap parameter.

GPS Minimum Interval

The GPS Minimum Interval parameter specifies the minimal distance between
two GPS stations that will be used in interpolation. If this distance is smaller
than the specified GPS Minimum Interval, then all EM61-MK2 readings located
between these two stations will be ignored. This parameter is useful in cases
when the operator stops for a moment and data are collected in one point. Lim-
ited accuracy of GPS positioning will create randomly distributed positions in
area adjacent to the stationary location of the system. If TrackMaker61MK?2 will
calculate positions of sensor in case offset values (GPS X and/or GPS Y Offsets)
are different than zero, positions of the EM61-MK2 will have quite large varia-
tions associated with apparent change of direction of the survey line caused by
randomly close spaced GPS positions. In most cases a value 2 or 3 times smaller
than average distance between two GPS stations is adequate, however the user
has to determine right value for this parameter which will depend on survey
conditions and first of all accuracy of the employed GPS receiver. To ignore the
effect of this parameter and to use all stations during creating XYZ file (i.e.
during testing when GPS antenna is stationary) set this parameter to zero.

Enter the GPS Minimum Interval in the edit box and check one of the two radio
buttons labeled meters and feet (indicating distance unit) in the GPS Minimum
Interval section (Figure 3.9).

GSA Message

This parameter is used to disable GSA message. This is to be used only if the
operator has specified in the data acquisition program (NAV61MK?2) that the
GPS Message will be pair GGA/GSA and for any reason message GSA was not
recorded. In such case the TrackMaker61MK2 will search for GPS quality in-
formation contained in not recorded GSA statement and it would conclude that
GPS readings are invalid. Disabling GSA message in this situation causes that
the program will use only information available from GGA message.
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PDOP Mask

The PDOP Mask is used to filter quality of GPS positions. The index called
PDOP (Position Dilution of Precision) measures the strength of satellite cover-
age for a given area. PDOP is affected by the number of satellites visible and
their relative positions in the sky. The smaller the number of PDOP the stronger
the satellite coverage is. When there are more than 5 satellites widely spaced
visible, the PDOP is 4 or less. However, when there are less satellites visible, or
they are unevenly spaced in the sky, PDOP values can be 6 or higher. In most
cases, the PDOP in open sky is less than 3, and most accuracies given for many
GPS systems are given for this norm. The index called GDOP covers time accu-
racy in addition, while the index HDOP is related only to horizontal position fix
(it is used when message GGA was selected). Refer to GPS documentation and
literature for more information related to error sources of GPS positioning.

The section PDOP Mask may differ depending on GPS NMEA message used. It
is related to PDOP parameter if GGA/GSA, POS, or GGK was employed dur-
ing the survey, to HDOP if GGA was used, to GDOP if LLK was used during
the survey, and it is invalid if GLL or LLQ message was used.

Enter the PDOP (HDOP or GDOP) value in the edit box in the PDOP Mask
section, Figure 3.9. All positions (as well as EM61-MK2 readings) associated
with GPS data of higher than specified value of this index will be ignored.

Corrections

Select type of differentially corrected position data to be used during the cre-
ation of XYZ file in the combo list box labeled Corrections. Four types of GPS
corrections are given: Raw (GPS), Differential (DGPS), Differential (RTK 3),
Differential (RTK 4), and Differential (RTK 5). Last three types of RTK (real
time kinematic) corrections are available only in high end of GPS receivers and
differently named depending on manufacturer, however in NMEA specifica-
tions they indicate Quality Parameter 3, 4, and 5. When Raw is selected, both
differentially corrected and raw GPS data are used to calculate positions of
EM61-MK2 stations.

Position Mode

This option is valid only if the pair GGA/GSA messages were used during data
collection. If radio button labeled 3D is checked then GPS data in mode 3D are
used, while when radio button 2D is checked then program uses 2D as well as
3D mode of GPS data.
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It should be noted that if any NMEA message indicates that GPS position (fix) is invalid
this data is ignored by the TrackMaker61MK2.

Creating XYZ Files With Positioned Readings

When all parameter are set and output file name is specified, the Proceed button is
activated in the Position Readings Using NAV61MK?2 File window. After you click the
Proceed button, the program begins to filter loaded data, calculates EM61-MK?2 stations
positions based on the recorded GPS readings, instant heading, and other specified pa-
rameters, and writes results to the XYZ output file. A progress bar at the bottom of the
screen shows the percentage of the file processed (Figure 3.10).

DD Position EM&1MEZ Readings Using NAVETMEK2Z File x

Output 34Z File IC:\D atahTimB1MEASRD_Siteh 200414 _shm.xpz
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Edit Parameters | Replot Last Output File
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Figure 3.10: Position EM61-MK2 Readings Using NAV6IMK2
File window during creating XYZ file

The speed of this operation depends on the size of the input file. After the output XYZ
file is created a two dimensional layout of the survey is displayed (Figure 3.11).
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Figure 3.11: Two dimensional layout of stations taken with the Geonics EM61. The
GPS X and Y offsets were set to zero (GPS antenna was located above
the center of the EMG61 sensor).

Figure 3.12: Two dimensional layout of stations taken with the EM61. The GPS

antenna location: GPS X Offset = -0.4 m and GPS Y Offset = 0.1 m

(the first W line was surveyed in N direction).
The image displayed in the Plot XYZ window shows the spatial layout of stations to
scale, based on the station coordinates as written to the created file. The display has
fixed colours. GPS positions are marked by larger grey dots while the EM61-MK2 sta-
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tions are plotted by smaller red dots. This plot window can be closed by clicking on Close
button (located in the top right corner of the window).

After the Plot XYZ window is closed a button Replot Last Output File becomes ac-

tive and the layout of data can be examined again. However, at this time original GPS
positions will not be displayed and only instrument positions will be represented by red
dots on the screen. Files created by this portion of the program can be also viewed at any
time using the File | View XYZ File menu.

After the file is created and its layout is examined it is possible (if required) to recreate
XYZ file with changed system geometry parameters. To do this, click Edit Parameters
button, the Edit NAV61MK?2 File Parameters window will appear again. After changes
are done, click the Proceed button to repeat procedure of creating XYZ file. See
example in Figure 3.12 where GPS antenna location was changed as compared to case
shown in Figure 3.11.

If the input file does not contain sufficient GPS information, or parameters are not
correctly selected, the program will display a warning message (Figure 3.13), and the
program will pause operation till the OK button is clicked in the warning window.

TrackMakerb1ME2 >

Mo GPS data with sufficient quality,
check file content and GPS parameters
~ settings in dialog. The procedure will stop.

Figure 3.13: Warning window

This message may indicate lack of GPS data in the file, however in most cases it reflects
lack of GSA messages when GGA/GSA was selected in the data acquisition program
(check Disable GSA Message), raw positions only when Differential button is checked,
too small value specified in GPS Time Gap section, not existing EM61-MK2 channels
specified in Select Data section, etc..

3.3 Positioning Readings Using External GPS File

After a data file is loaded the TrackMaker61MK2 main window displays the most im-
portant parameters of the entered data file (Figure 3.14). At the top of the window the
current file name, date of file and optionally original file name (as entered in the field),
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Figure 3.14: Position Readings menu

and start and end times in local time (field computer clock) and UTC time (GPS time
in NMEA messages) are displayed. Below, in the left window frame labeled Data File
Contents a total number of EM61-MK2 readings, number of GPS positions recorded,
number of invalid GPS positions (with not valid checksum), number of survey lines,
comments, number of readings in the instrument mode 4 and D, and number of used fi-
ducial markers in the field are given. In the right frame labeled Data File Settings listed
are: name of the instrument (fixed), Sensor Size, type of used GPS NMEA message,
GPS X and Y offsets (in Distance Units), and survey mode.

The Position Sensors Using External GPS File item of the Position Sensors menu allows
you to position EM61-MK2 stations based on separately logged GPS positions which
were postprocessed by a GPS software and then exported to ASCII format file. It is as-
sumed that GPS positions were concurrently recorded by NAV61MK?2 program during
the survey. Select Position Sensors | Position Readings Using External GPS File from
the main program menu, as shown in Figure 3.14.

After the selected menu item is clicked the Position EM61-MK2 Readings Using Exter-
nal GPS File window will be displayed in the centre of the screen, Figure 3.15.
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Parameters in Positioning Readings Using External GPS File Window

Several parameters which affect the contents and format of the created output (XYZ)
file must be specified. These are GPS and XYZ file names, parameters describing
contents of the created file and parameters related to GPS as well as to electromagnetic

data.

[I7] Position EM6TMK2 Readings Using External GPS File

Input GPS File |
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— Type of Output File
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Figure 3.15: Position EM61-MK?2 Readings Using External GPS
File window

Edit Parameters

The TrackMaker61MK2 main window (Figure 3.15) displays the most impor-
tant parameters of the entered data file. In case some parameters were wrongly
entered in the field it is possible to change them using Edit Parameters option
(the same option is available in the File menu of the TrackMaker61MK2 main
screen). Click on the Edit Parameters button and Edit NAV61MK?2 File Param-
eters window will appear (Figure 3.16).

The window displays parameters that the user can edit. These are: the EM61-
MK?2 instrument type, Sensor Size, Distance Units and GPS X and Y offsets.

If all parameters were correctly specified in the field then clicking on OK or
Cancel button will accept these entries. In case some of the parameters require
modification they can be entered in appropriate text boxes located under label
Current Settings. The Instrument Type, Sensor Size, and Distance Units param-
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Figure 3.16: Edit NAV61 File Parameters

eters can be selected from combo list boxes, while GPS X and GPS Y offsets
must be entered in appropriate text boxes. Example of NAV61MK2 File Info
window with modified parameters is shown in Figure 3.17.

[ Edit MAVEIMEZ File Param... — O b4

Parameter Original from File  Current Settings

Ingtrument Type:  Standard

Sensor Size: 1.0%7.0m
Distance Units: feet

GPS = Offset 1]

GPS 'Y Offset i]

GFS offsets are meazured in coresponding Distance Units

from File | Cancel | QK [}l

Figure 3.17: Modified parameters in Edit
Parameters dialog

Clicking on the OK button will accept any changes in parameters, clicking on
the Cancel button will cause the program to use initial parameters (state when
window was displayed), while clicking on the button from File will change
parameters to original values (listed in fields under label Original from File).
After the buttons OK, Cancel or from File are clicked the Edit NAV61MK2 File
Parameter will disappear.

Any updates in this window are valid only for duration of the program. The data
file will remain the same unless it Saved or Saved As in File menu.
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Input GPS File

Click on the Input GPS File button. The Select External GPS ASCII File win-
dow is displayed (Figure 3.18).

] Select Extemal GPS ASCII File

« © 4 [« Windows (C) > Date > Trm6IMK2 > SRD Site v o P Search SRD Site

Organize = Newfolder E- M @
A Name Date modified Type Size
5 Quick aceess

| TRextig.ASC 2002-04-04.5:31 PM ASCFile 2
OneDrive
[ This PC
8 30 Objects
B Desktop
Documents
& Downloads
b Music
=] Pictures
B videos
L, Windows (C)
& Network

[0 JERZY-FINE v o< >

File name: [TRext18.45C -] Poslpn Files (~ct"asc "pos)

Cancel
Figure 3.18: Select External GPS File dialog

Select a file name and click the Open button. The Select External GPS ASCII
File window will close and the selected file name will be displayed beside the
Input GPS File button in the Position Sensors Using External GPS File window.
The external GPS file must be in ASCII (text) format with column delimiters

set to comma or spaces. Several examples of the external GPS files are given in
Appendix B.

Output File

Click on the Output XYZ File button. The Select Output File window is dis-
played (Figure 3.19).

€« v <« Windows (C:) > Data » Tm6IMK2 » SRD_Site v O & Search SRD_Site
Organize v New folder - @
A Name Date modified Type Size

 Quick access -
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B Music 77 Co01_geodeticayz V2 File 1,668 KB
= Pictures 7] Co01_geodetic_GPSayz V2 File ke
8 Videas ) com Uhmay= XVZ File 1,668 KB
1) CO01_UTMm_GPSxyz XVZ File ke

i Windows (C)
©

File name: | se14 Merged

Save as type: | XVZ Files (*xy2)

o e
Figure 3.19: Select Output File dialog
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Select a file name and click the Save button. The Select XYZ File window will
close and the selected file name will be displayed beside the Output XYZ File
button in the Position Sensors Using External GPS File window.

When all three, Input NAV61MK?2, Input GPS and Output files are specified
the Proceed button in the Position EM61-MK2 Readings Using External GPS
File becomes active (Figure 3.20).

[17] Position EM6TMK2 Readings Using External GPS File

Input GPS File: | IC:\Data\TrmE1MK2\SF|D_Site\TF|th'IB.ASC
Output 72 File | IC:\Data\TlmS‘IMK2\SF|D_Site\Se14_Merged.:-cyz

Type of Output File
Edit Parameters | FiePlat Lazt Output File ’7(5‘ Generic ™ Geosoft
—Foimat of the External GPS File——————————  Select EMB1-ME2 Channels

& UTM Coordinates  Column I Chi [v Ch3 v ChD
Unitg ———————— v Ch2
& meters Easting /LON  [Z — ZTEh[I Llen
& feet Northing /LaT [T | StandardD (STD-D) =
7 1S Survey feet Tirne [hh:ron:ss) H_ — Select Amplitude Scale and Time

" Geodstic [DDD.DD...] @ Linear

~ Compressed

UTCATAI-GPS Time L I 18 d
W HIEEEY seeonts ¥ Include Time Stamp (Local)

—GPS Time Gap GPS Minimurm Interval — — Output File Comments
|5 seconds In_g * meters ¥ Header Info Proceen
 feet ¥ Field Comments o
|
|
Lancel | E it

Figure 3.20: Position EM61 Readings Using External GPS File
window

Select EM61-MK2 Channels

To select a data type (component and dipole mode) click on desired check
buttons labeled Chl, Ch2, Ch3, Ch4 or ChT, ChD, and ChN. Data is always
placed in the created XYZ file in the following order: X coordinate (Easting or
Longitude), Y coordinate (Northing or Latitude), and Ch1, Ch2 through ChD.
This data may be followed by a column containing Time Stamp (this optional
parameter is located in a section Select Amplitude Scale).

If during data collection more than one instrument mode was used then select
Instrument Mode to be used during the creation of XYZ file in the combo list
box located below selection of EM61-MK2 channels. Change of the EM61-MK2
mode may change selection of available channels.

If parameter Header Info in Include in File section is checked a line listing all
parameters in the file will be placed as a header of the created XYZ file.
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Select Amplitude Scale

Readings can be written in the output file in Linear (original) scale, or Com-
pressed, as the signed square root of each value. Check the appropriate radio
button in the Select Amplitude Scale section.

Type of Output File

Check the option appropriate for the contouring software used. The Generic
option will create a three or more column file without any text strings. This file
can be used as an input file for many contouring packages (including Surfer).
Geosoft format will cause the program to write a message LINE # at the begin-
ning of each survey line.

Include in File

This section contains two check boxes labeled Header Info and Field Com-
ments. When Header Info box is checked the file will contain a header listing
type of coordinates and names of channels contained in each column of created
XYZ file. Checking box labeled Field Comments will cause the program to
write text of all field comment (entered by the operator during the survey) in to
the created file.

GPS Time Gap

Differentially corrected GPS data often has gaps, due to differences in the con-
stellation of satellites visible to two (fixed and moving receivers), lack of beacon
signal, surveying near trees, buildings, and other elevated obstructions. These
gaps are filled by TrackMaker61MK2 with the assumption that the GPS receiver
speed is essentially constant and that it moves along a straight line during the
gaps.

The GPS Time Gap parameter specifies the maximum time during which the
EM61-MK?2 data will be linearly interpolated between two GPS positions. Enter
this parameter (in seconds) in the edit box labeled seconds in the GPS Time
Gap section (Figure 3.20). In most cases a value 2 to 3 times larger than the
GPS data acquisition frequency is adequate, however the user has to determine
this value based on the survey specific conditions and requirements. To ignore
effect of this parameter enter a large number of seconds (i.e. 300 or more) as
GPS Time Gap parameter.

GPS Minimum Interval

The GPS Minimum Interval parameter specifies the minimal distance between
two GPS stations that will be used in interpolation. If this distance is smaller
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than the specified GPS Minimum Interval, then all EM61-MK2 readings located
between these two stations will be ignored. This parameter is useful in cases
when the operator stops for a moment and data are collected in one point. Lim-
ited accuracy of GPS positioning will create randomly distributed positions in
area adjacent to the stationary location of the system. If TrackMaker61MK?2 will
calculate positions of sensor in case offset values (GPS X and/or GPS Y Offsets)
are different than zero, positions of the EM61-MK2 will have quite large varia-
tions associated with apparent change of direction of the survey line caused by
randomly close spaced GPS positions. In most cases a value 2 or 3 times smaller
than average distance between two GPS stations is adequate, however the user
has to determine right value for this parameter which will depend on survey
conditions and first of all accuracy of the employed GPS receiver. To ignore the
effect of this parameter and to use all stations during creating XYZ file (i.e.
during testing when GPS antenna is stationary) set this parameter to zero.

Enter the GPS Minimum Interval in the edit box and check one of the two radio
buttons labeled meters and feet (indicating distance unit) in the GPS Minimum
Interval section (Figure 3.20).

Format of the External GPS File

This section describes contents of the External GPS File. It is assumed that the
file is in ASCII (text) format, and columns are delimited by comma or spaces.
Parameters that have to be specified include: type of coordinates (UTM or
Geodetic), identifying numbers of columns corresponding to each coordinate
and time, and indicating time of GPS data (UTC or satellite time). These pa-
rameters are necessary for TrackMaker61MK?2 to correctly calculate positions of
each sensor.

Post-processed GPS files in ASCII (text) format include UTM or Geodetic
(Latitude/Longitude) coordinates. To select coordinates click Geodetic or UTM
radio buttons (Figure 3.20). Geodetic coordinates, Latitude and Longitude are
given in degrees. The program assumes format DDD.DDDDDDDD. Format
DDMM.MMMMM (native format found in NMEA GPS messages) is not sup-
ported by this option of TrackMaker61MK2. UTM coordinates can be generat-
ed in meters or feet. To select units for UTM coordinates click one of the radio
buttons located in the Units section located at the UTM radio button (Figure
3.20). These radio buttons are active only when the radio button labeled UTM is
selected.

Specify columns where each coordinate and time in text boxes labeled Column.
Valid format of the time is hh:mm:ss.
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Check box labeled UTC/Satellite Time Lag has to be checked and a current
UTC/GPS Time Lag value specified if your GPS software is using Satellite
Time to time stamp positions. NMEA messages, and therefore NAV61MK2
data file contains UTC time as a time of GPS reading. In most cases, if GPS log-
ger is used to save data Satellite Time is used. Please refer to your GPS software
manual. Currently difference between UTC and Satellite clocks is 18 seconds,
however this value changes.

Creating XYZ Files With Positioned Readings

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Position Sensors Using External GPS File window. After you
click the Proceed button, the program begins to read input files, replaces GPS positions
by positions given in GPS file, calculates EM61-MK2 stations positions based on the re-
corded GPS readings, instant heading, and other specified parameters, and writes results
to the XYZ output file (or files depending on the Output Data setting). A progress bar
at the bottom of the screen shows the percentage read (Figure 3.21).

[17] Position EM6TMK2 Readings Using External GPS File

Input GPS File | IC:\Data\Trm81MK2\SHD_Site\THth‘ISASC
Qutput =77 File | IC:\Data\TlmS‘IMK2\SF|D_Site\Se14_Merged.:-cyz

Type of Output File
’7 " Generic ¢ Geogaft

Edit Parameters | RePlot Last Output File
—Foimat of the External GPS File——————————  Select EMB1-ME2 Channels

& UTH Coordinates  Column [v Chi [# Ch3 [¥ ChD
Units ————— ¥ Ch2
& meters Easting /LON  [Z — ZTEh[I Llen
& feet Nothing /LaT [T | Standard D (5TDD) =
" 1S Survey fest Tirne [hk:ron:ss) |3_ — Select Amplituds Scale and Time

" Geodstic [DDD.DD...] g Linear

Compreszed

UTCAT&I-GPS Time L I 18 d

b me ~eap seeonts ¥ Include Time Stamp (Local)

—GPS Time Gap GPS MinimuF Inkerval — — Output File Comments -
|5 seconds In_g + meters ¥ Header Info ;
’7  feet ¥ Figld Comments

Filters Input Files LCancel | E xit |

Figure 3.21: Position Sensors Using External GPS File window
during creating XYZ file

The speed of this operation depends on the size of input files. After the output XYZ file
is created a two dimensional layout of the survey is displayed (Figure 3.22).
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Figure 3.22: Two dimensional layout of stations taken with the Geonics EM61-MK?2 and
GPS. The GPS antenna was located above the center of the EM61-MK2
sensor (GPS X and Y offsets are set to zero).

Figure 3.23: Two dimensional layout of stations taken with the Geonics EM61-MK2 and
GPS. The GPS antenna was located off the center of the EM61-MK2 sensor
(GPS X offset = 1.0 m and GPS'Y offset =0).
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The image displayed in the Plot XYZ window shows the spatial layout of stations to
scale, based on the station coordinates as written to the created file. The display has
fixed colours. GPS positions are marked by larger grey dots while the EM61-MK2 sta-
tions are plotted by smaller red dots. This plot window can be closed by clicking on
Close button (located in the top right corner of the window).

After the Plot XYZ window is closed a button Replot Last Output File becomes active
and the layout of data can be examined again. However, at this time original GPS posi-
tions will not be displayed and all instruments will be represented by the same colour on
the screen. Files created by this portion of the program can be also viewed at any time
using the File|View XYZ File menu.

After the file is created and its layout is examined it is possible (if required) to recreate
XYZ file with changed system geometry parameters. To do this, click Edit Parameters
button, the Edit NAV61MK?2 File Parameters window will appear again. After changes
are done, click the Proceed button to repeat procedure of creating XYZ file. See
example in Figure 3.23 where GPS antenna location was changed as compared to case
shown in Figure 3.22.

If the input file does not contain sufficient GPS information, contains different time
range, or parameters are not correctly selected, the program will display a warning mes-
sage.

3.4 Positioning Readings Using Files in Geonics (M61) Format

The Position Readings Using Geonics (M61) File option allows you to position EM61-
MK?2 stations based on Real Time GPS data which were recorded in NAV61MK2

data file during the survey and then converted and processed in Geonics program
DAT61MK2. The most common processing of data in DAT61MK2 may include shifting
EM61-MK?2 readings, removing offsets, deleting unwanted readings and survey lines.
This program is also very useful for plotting data in profile view. The DAT61MK?2 has its
own GPS Positioning option however it does not support NMEA messages other than
GGA, filter for PDOP Mask, GPS Minimum Interval and GPS Antenna offsets.

This option allows to use data processed in DAT61MK?2 with all benefits provided by the
TrackMaker61MK2. However one condition must be met: while processing and editing
data file in DAT61MK2 order of survey lines can not be changed. In other words, any
number of readings can be removed but remaining readings must be placed in the file in
order they were recorded. At the same time adding data from other files is not allowed.
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Select Position Sensors | Position Readings Using Geonics (M61) Files from the main

program menu, as shown in Figure 3.24.

6 TrackMaker61MK2

File = Position Readings Convert Data Files Data Transfer Help
Position Readings Using MAVE1ME2 Data Files
Position Readings Using External GPS File
Position Readings Using Geonics (M61) File

ng Nava1MK2 data

(

Copyright © 2002-2021 Geomar Software Inc.

Figure 3.24: TrackMaker61MK?2 Position Readings menu

After the selected menu item is clicked the Position EM61-MK2 Readings Using

Geonics (M61) File window will be displayed in the centre of the screen, Figure 3.25.

Parameters in Positioning Readings Using Geonics (M61) File window

Several parameters which affect the contents and format of the created output (XYZ)

file must be specified. These are the DAT61MK2, and XYZ file names, parameters

describing contents of the created file and parameters related to electromagnetic as well

as to GPS data.

Input EM File

Click on Input EM File button. The Select Geonics DAT61MK2 Input File

window is displayed (Figure 3.26).
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[I[] Position EM&1-MK2 Readings Using Geonics (.MB1) File

Input EM File

DOutput 32 File

— Tope of Dutput File
Replat Last Dutput File & Genefic ~ Geosoft
Select Amplitude Scale — Select EMET-MK2 Channels
@ Linear " Compreszed | ¥ Ch ¥ Ch3 W ChD
— Output Coordinates MWGES84)———————— W Chz I ChT [~ ChH
~Format———————
 Geodstic # BOD.DODDOOOD | Standard D [5TD-D) |
€ DDDMM MMM W Time Stamp
& UTM —Unitg———————— —Select Original MMEA Message———————
IMetels vl GGA/GSE | 7 meters {ee
—GPS Time Gap — GPS Minimum Interval—— — GPS Antenna Offsets—————
f* meters o
|5 seconds IIJ.2 IEI.EID ID.DD
" feet " ¥ " feet
~HDOP—————— Comections————— ~Include inFile————
¥ Header Info
|4.D IF! GFPS vI ) B d
BRA/GSA il ) ¥ Field Comments e

Cancel | Exit |
Figure 3.25: Position EM61-MK?2 Readings Using Geonics (M61)
File dialog
[T Select Geonics DATE1MKZ Input File
4 [« Data > TmEIMK2 > SRD Site v & | O SearchSRDSie
Organize v New folder =~ m @
A Name h Date modified Tipe
7 Quick access -
J 201410_AB.m61 2021-02-04 4:38 PM M61 File
OneDrive

& This PC

ZJ 30 Objects

[ Desktop

Documents

J Downloads

B Music

[&] Pictures

B videos

. Windows (C)
¥ Network wf< >

File name: ‘ZOTMOJB mé1 v‘ | Geonics DATEIMK Fies (*M61 |

Figure 3.26: Select M61 File dialog

The window lists files with extension name M61. Select a file name and click the
Open button. The Select Geonics DAT61MK?2 Input File window will close and
the selected file name will be displayed beside the Input EM File button.
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Output File

Click on the Output XYZ File button. The Select Output File window is dis-
played (Figure 3.27).

[ select Output File X
A [« Data > TmSIMK2 5 SRDSite v o 2 Search SRD_Site
Organize = New folder =~ @

" Name Tipe
s Quick access = - -
] 200414 shmxoff xyz

OneDrive ] 200414_shmxoff_GPS.xyz
7] 200414_shmxoffnoxyz

XYZ File
XYZ File
XYZ File

[ This PC o
] 200414 shmxoffno_GPS.xyz XVZ File
B 3D Objects P
| con_geodeticxyz XVZ File
B Deskiop ] con1_geodetic_GPSxyz XVZ File
[%] Documents ) Con1_UTMmmyz X¥VZ File
& Downloads | CoD1_UTMm_GPSxyz XYZ File
B Music ) Sel4 Mergedayz XYZ File
= Pictures 7 se14_Merged-2xyz XVZ File
& Videos 7] Se14 Merged-2_GPSxyz XYZ File v

v < >

File name: | 2014M61.V] -

Save astype: | XVZ Files (“ayz) v

~ Hide Folders Cancel
Figure 3.27: Select Output File window

Select a file name and click the Save button. The Select X'YZ File window will
close and the selected file name will be displayed beside the Output XYZ File
button in the Position EM61-MK2 Readings Using Geonics (M61) File window.
When both, Input and Output files are specified the Proceed button in the Posi-
tion EM61-MK2 Readings Using Geonics (M61) File becomes active (Figure
3.28).

Select EM61-MK2 Channels

To select a data type click on desired check buttons labeled Ch1, Ch2, Ch3, Ch4
or ChT, ChD, and ChN. Data is always placed in the created XYZ file in the fol-
lowing order: X coordinate (Easting or Longitude), Y coordinate (Northing or
Latitude), and Ch1, Ch2 through ChD and ChN. This data may be followed by
one column containing Time Stamp (see check box in the same section).

If during data collection more than one instrument mode was used then select
Instrument Mode to be used during the creation of XYZ file in the combo list
box located below selection of EM61-MK2 channels. Change of the EM61-MK2
mode may change selection of available channels.

If parameter Header Info in Include in File section is checked a line listing all
parameters in the file will be placed as a header for each created XYZ file.
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[I[] Position EM&1MK2Z Readings Using Geonics1MKZ File

Input EM File | IE:\Data\TlmEﬂMK2\SHD_Site\2D141D_AB.mB1

Output 3Z File | IE:\Data\TlmEﬂMK2\SHD_Site\2EI'I4MB1_\:".>¢92

— Tope of Dutput File
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— Output Coordinates MWGES84]—————————— W Chz I ChT [~ ChH
~Format————
" Geodstic # DOD.DDDDDDDD | Standard D (5TD-DY) |
£ DDDMAM MMMbM ¥ Time Stamp
& UTM —Unitg——————— — Select Original MME2 Meszage
IMeters vl GGA/GSE | (% meters {ee
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Figure 3.28: Position EM61-MK?2 Readings Using Geonics (M61)
File dialog

Select Amplitude Scale

Readings can be written in the output file in Linear (original) scale, or Com-
pressed, as the signed square root of each value. Check the appropriate radio
button in the Select Amplitude Scale section.

Select Original NMEA Message

Specify name of NMEA GPS message that was used during data collection.
Geonics format does not include type of NMEA message and TrackMaker-
61MK?2 uses this parameter to properly process GPS data.

If a message that contains position in other than Geodetic coordinates (LLK,
LLQ, and Leica TPS) is indicated then two radio buttons labeled meters and
feet are enabled. Please specify proper distance units.
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GPS Antenna Offsets

Specity values of X and Y GPS Antenna offsets and units. Geonics format does
not include these parameters, therefore TrackMaker61MK?2 uses values that are
indicated in this section of the window.

Type of Output File

Check the option appropriate for the contouring software used. The Generic
option will create a three or more column file without any text strings. This file
can be used as an input file for many contouring packages (including Surfer).
Geosoft format will cause the program to write LINE # at the beginning of each
survey line.

Include in File

This section contains two check boxes labeled Header Info and Field Com-
ments. When Header Info box is checked the file will contain a header listing
type of coordinates and names of data contained in each column of created
XYZ file. Checking box labeled Field Comments will cause the program to
write text of all field comment (entered by the operator during the survey) in to
the created file.

Output Coordinates

Positions can be written in the output file as geodetic (geographical) coordinates
(Latitude/Longitude) or they can be converted to UTM coordinates. The pro-
gram uses the WGS1984 datum. To select coordinates click Geodetic or UTM
radio buttons (Figure 3.28).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can be
written in two formats DD.DDDDDDDD or DDMM.MMMMM (native for-
mat found in NMEA GPS messages). To select which format click the appropri-
ate radio button in Format section located at the radio button labeled Geodetic.
This section is active only when radio button Geodetic is selected (Figure 3.28).

UTM coordinates can be generated in meters or feet. To select units for UTM
coordinates click on a combo box placed in the Units section located at the
UTM radio button (Figure 3.28) and select proper units: Meters, Feet, or US
Survey Feet. This combo box is active only when radio button labeled UTM is
selected.
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GPS Time Gap

Differentially corrected GPS data often has gaps, due to differences in the con-
stellation of satellites visible to two (fixed and moving receivers), lack of beacon
signal, surveying near trees, buildings, and other elevated obstructions. These
gaps are filled by TrackMaker61MK2 with the assumption that the GPS receiver
speed is essentially constant and that it moves along a straight line during the

gaps.

The GPS Time Gap parameter specifies the maximum time during which the
EM61-MK?2 data will be linearly interpolated between two GPS positions. Enter
this parameter (in seconds) in the edit box labeled seconds in the GPS Time
Gap section (Figure 3.28). In most cases a value 2 to 3 times larger than the
GPS data acquisition frequency is adequate, however the user has to determine
this value based on the survey specific conditions and requirements. To ignore
effect of this parameter enter a large number of seconds (i.e. 300 or more) as
GPS Time Gap parameter.

GPS Minimum Interval

The GPS Minimum Interval parameter specifies the minimal distance between
two GPS stations that will be used in interpolation. If this distance is smaller
than the specified GPS Minimum Interval, then all EM61-MK2 readings located
between these two stations will be ignored. This parameter is useful in cases
when the operator stops for a moment and data are collected in one point. Lim-
ited accuracy of GPS positioning will create randomly distributed positions in
area adjacent to the stationary location of the system. If TrackMaker61MK2 will
calculate positions of sensor in case offset values (GPS X and/or GPS Y Offsets)
are different than zero, positions of the EM61-MK2 will have quite large varia-
tions associated with apparent change of direction of the survey line caused by
randomly close spaced GPS positions. In most cases a value 2 or 3 times smaller
than average distance between two GPS stations is adequate, however the user
has to determine right value for this parameter which will depend on survey
conditions and first of all accuracy of the employed GPS receiver. To ignore the
effect of this parameter and to use all stations during creating XYZ file (i.e.
during testing when GPS antenna is stationary) set this parameter to zero.

Enter the GPS Minimum Interval in the edit box and check one of the two radio
buttons labeled meters and feet (indicating distance unit) in the GPS Minimum
Interval section (Figure 3.28).
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PDOP Mask

The PDOP Mask is used to filter quality of GPS positions. The index called
PDOP (Position Dilution of Precision) measures the strength of satellite cover-
age for a given area. PDOP is affected by the number of satellites visible and
their relative positions in the sky. The smaller the number of PDOP the stronger
the satellite coverage is. When there are more than 5 satellites widely spaced
visible, the PDOP is 4 or less. However, when there are less satellites visible, or
they are unevenly spaced in the sky, PDOP values can be 6 or higher. In most
cases, the PDOP in open sky is less than 3, and most accuracies given for many
GPS systems are given for this norm. The index called GDOP covers time accu-
racy in addition, while the index HDOP is related only to horizontal position fix
(it is used when message GGA was selected). Refer to GPS documentation and
literature for more information related to error sources of GPS positioning.

The section PDOP Mask may differ depending on GPS NMEA message used. It
is related to PDOP parameter if GGA/GSA, POS, or GGK was employed dur-
ing the survey, to HDOP if GGA was used, to GDOP if LLK was used during
the survey, and it is invalid if GLL or LLQ message was used.

Enter the PDOP (HDOP or GDOP) value in the edit box in the PDOP Mask
section, Figure 3.28. All positions (as well as EM61-MK2 readings) associated
with GPS data of higher than specified value of this index will be ignored.

Corrections

Select type of differentially corrected position data to be used during the cre-
ation of XYZ file in the combo list box labeled Corrections. Four types of GPS
corrections are given: Raw (GPS), Differential (DGPS), Differential (RTK 3),
Differential (RTK 4), and Differential (RTK 5). Last three types of RTK (real
time kinematic) corrections are available only in high end of GPS receivers and
differently named depending on manufacturer, however in NMEA specifica-
tions they indicate Quality Parameter 3, 4, and 5. When Raw is selected, both
differentially corrected and raw GPS data are used to calculate positions of
EM61-MK2 stations.

It should be noted that if any NMEA message indicates that GPS position (fix) is invalid
this data is ignored by the TrackMaker61MK2.
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Creating XYZ files with positioned readings

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Position Readings Using Geonics (M61) File window. After
you click the Proceed button, the program begins to read the input file, calculates EM61-
MK?2 stations positions based on the recorded GPS readings, instant heading, and other
specified parameters, and writes results to the XYZ output file. A progress bar at the
bottom of the screen shows the percentage of the file processed (Figure 3.29).

[I[] Position EM&1MK2 Readings Using GeonicsB1MEK2 File

Input EM File | IC:\Data\TrmB1MK2\SHD_Site\2D141EI_.t‘-\B.mE'I
Dutput =72 File | IC:\Data'\TrmB1MK2\SF|D_Site\2D'I4ME1_V.H_I,J2

— Type of Output File
Replat Last Output File | ¥ Generic i Geosoft
Select Amplitude Scale — Select EMET-MEZ Channelz
& Linear " Compressed | W Chi [V Ch3 ¥ ChD
— Output Coordinates WGES84)—————————— ¥ Cha [ ChT [~ Chi
~Format——————
€ Geodelc | @ DDD DODDDODD | Stendard O (5T0-0) =
0 DDDMM MMMMM ¥ Time Stamp
& UTM —Untg———————— — Select Original NMEA Message
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—GPS Time Gap — GPS Minimum Interval—— — GPS Antenna Offsets——————————————
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Figure 3.29: Position EM61-MK?2 Readings Using Geonics (M61)
File window during creating XYZ file

The speed of this operation depends on the size of the input file. After the output XYZ
file is created a two dimensional layout of the survey is displayed (Figure 3.30).

The image displayed in the Plot XYZ window shows the spatial layout of stations to
scale, based on the station coordinates as written to the created file. The display has
fixed colours. GPS positions are marked by larger grey dots while the EM61-MK2 sta-
tions are plotted by smaller red dots. This plot window can be closed by clicking on Close
button (located in the top right corner of the window).
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Figure 3.30: Two dimensional layout of stations taken with the Geonics EM61-MK?2.
The GPS X and Y offsets were set to zero (GPS antenna was located above
the center of the EM61-MK?2 sensor).

Figure 3.30: Two dimensional layout of stations taken with the Geonics EM61-MK2. The
GPS X and Y offsets: GPS X Offset = 0.4 m and GPS Y Offset = 0.02
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After the Plot XYZ window is closed a button Replot Last Output File becomes ac-

tive and the layout of data can be examined again. However, at this time original GPS
positions will not be displayed and only instrument positions will be represented by red
dots on the screen. Files created by this portion of the program can be also viewed at any
time using the File | View XYZ File menu.

After the file is created and its layout is examined it is possible (if required) to recre-
ate XYZ file with changed system geometry parameters run this option again. After
changes are done, click the Proceed button to repeat procedure of creating XYZ file.
See example in Figure 3.31 where GPS antenna location was changed as compared to
case shown in Figure 3.30.
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Convert Data Files

Convert menu of TrackMaker61MK2 program allows you to convert the NAV61MK2 binary file
to other formats. There are five items associated with the Convert menu (Figure 4.1):

convert NAV61MK?2 file to Geonics DAT61MK?2 (.P61) format,
convert NAV61MK?2 file to general format ASCII file,

retrieve and position field comments from NAV61MK2,
convert GXY file to ASCII file containing positions,

correct system time constant delay in XYZ files.

64 TrackMaker61MK2 - X

File Position Readings Convert Data Files Data Transfer Help
[k MAVETMEZ (P61) Files to Geonics (ME1) Format
MNAVETMEZ Files to ASCIl Format
Retrieve and Position Field Comments
_— GXY File to XY (ASCIl) Format
Correct Time Constant Delay in XYZ File

K2

Copyright © 2002-2021 Geomar Software Inc.

Figure 4.1: Convert Data Files menu

Files converted to Geonics M61 format can be further processed by the Geonics DAT61MK?2
program, while files converted to general ASCII format can be easily reformatted and used by
other software. While retrieving comments from NAV61MK?2 file, the program retrieves text of
the comment and their position based on neighbouring GPS records. When converting GXY
files (containing only GPS positions and field comments) the program generates simple XY type
of file (coordinates in two columns with optional parameters). Correct Time Constant Delay item
provides correction for specified time constant delay of the system (EM instrument specific time
constant combined with GPS latency). Any XYZ file containing sequential time stamp column
can be corrected while using this option.
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It should be noted that three first items of Convert Files menu are disabled. They are enabled
automatically after the NAV61MK?2 data file is loaded in File menu (Figure 4.2).

64 TrackMaker61MK2 - x

File Position Readings | Convert Data Files Data Transfer Help
MNAVETMEZ (PE1) Files to Geonics (ME1) Format
MNAVETIMKZ Files to ASCIl Format
Retrieve and Position Field Comments

GXY File to XY (ASCIl) Format

Local [Log . .
Correct Time Constant Delay in XYZ File
Starter
Ended  2340:33.465 || Ended 04070843
—Data File Contents———————  ~ Data File Settings
EMET-MEZ2 Readings 14728 EMET-MEZ Type: Standard
GPS Positions: an3 Senszor Tupe: 1x05m
Invalid GPS Data: 18 Distance Units:  meters
Esternal Senzor Data: 0 GPS Message: GGAMGSA
Survey Lines: 1 GPS = Offset: 1]
Comments: 1] GPS ' Offset 5
Mode 4 readings: 14728 Survey Mode: At
Mode D readings: 0 Ext.Senszor Type: Mone
Fiducial Markers: a GPS Elevation:  Available

Figure 4.2: Convert Data Files menu after NAV61MK? file is loaded
to the program

Selected examples of file formats created by TrackMaker61MK2 are given in Appendix B of this
manual.

4.1 Convert NAV61MK2 Data to Geonics DAT61MK2 (M61) Format

The Convert NAV61MK2 to Geonics M61 Format option allows you to convert
NAV61MK?2 files to Geonics DAT61MK2 format. Select Convert| NAV61MK2 to
Geonics M61 Format from the main program menu, as shown in Figure 4.2.

After the selected menu item is clicked the Convert NAV61MK?2 Files (P61) to Geonics
M61 Format window will be displayed in the centre of the screen, Figure 4.3.
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Convert NAVE1MKZ Data to Geonics M&1 Format

L

Clutput File (ME1) k]

Output Data
¥ Include GPS Pasitions Wiewy Converted File | Convert
¥ Include Conmmerts Cancel | Exit |

Figure 4.3:  Convert NAV61MK? Files to Geonics M61 Format

Parameters in Convert NAV61MK2 Data to Geonics M61 Format Window

Several parameters which affect the contents and format of the created output (M61)
file must be specified. The first is Output File name. Output Data parameters if checked
cause the program to write GPS positions, Comments entered in the field. Time Stamp
for each reading is included automatically.

Output File (M61)

Click on the Output File (M61) button. The Select Output File dialog is dis-
played (Figure 4.4).

Select Output File X

P < Windows (C) » Data > Trm61MK2 > SRD_Site v o ) Search SRD_Site
Organize + New folder > @
A Neme Date modified Trpe Size
s Quick access _
71 201410_A8.m61 2021-02-04 438 PM Mé1 File 318Ke

OneDrive

[ This PC
3D Objects

=] Pictures
B Videos
e ©

File name; | 200416_001| v

Save as type: | Geonics EM1-MK2 Files (*.M61)

A Hide Folders Cancel
Figure 4.4: Select Output File dialog

Select a file name and click the Save button. The Select Output File window will
close and the selected file name will be displayed beside the Output File (M61)
button in the Convert NAV61MK2 to Geonics M61 Format window.

When Output file is specified the Convert button in the Convert NAV61MK?2 to
Geonics M61 Format window becomes active.
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Output Data

TrackMaker61MK2 can generate a file with EM61-MK2 data as recorded by
NAV61MK?2 data acquisition program. The file may also contain GPS positions
and Comments. Check appropriate check boxes in section labeled Data Output.
GPS positions are properly written in Geonics DAT61MK2 format regardless
which GPS message was used during the survey.

Converting NAV61MK2 Data to Geonics DAT61MK2 (M61) Format

When all parameters are set and input and output file names are specified, the Convert
button is activated in the Convert NAV61MK2 File to Geonics M61 Format window. Af-
ter you click the Convert button, the program begins to read the input file, converts data
to DAT61MK?2 format and writes results to the output file. A progress bar at the bottom
of the screen shows the percentage of the file read (Figure 4.5).

Convert NAVE1MKZ Data to Geonics M&1 Format X
Output File [ME1) | IC:\Data\TrmB‘IMK2\SHD_Site\2DDd1B_DD1.mB‘I

Output Data - :
¥ Include GPS Pasitions Wiewy Converted File | Convert I\\

v Include Conmmerts

Cancel | Exit |

Figure 4.5: Convert NAV61MK?2 Files (P61) to Geonics M61
Format window during data processing

The speed of this operation depends on the size of the input file. After the output (M61)
file is created the View Converted File button becomes active. Clicking on this button
will display first 63 Kbytes of the created file.

The created file can be loaded to the Geonics DAT61MK?2 program. It should be noted
that the created file contains original GPS positions, without corrections for GPS X and
Y Offsets specified during the survey.

Clicking Cancel button will clear text box at Qutput File (M61) button. Click on Exit
button to close the Convert NAV61MK?2 Files (P61) to Geonics M61 Format window.

An example of data file in Geonics DAT61MK2 (M61) format is given in Appendix B.
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4.2 Convert NAV61MK2 Data to ASCII Format

The Convert NAV61MK2 Data to ASCII Format option allows you to convert
NAV61MK?2 binary files to ASCII format, which can be viewed with any text editor and
then easily converted to the other format. Select Convert | NAV61MK2 to ASCII Format
from the main program menu, as shown in Figure 4.2.

After the selected menu item is clicked the Convert NAV61MK?2 Files to ASCII Format
window will be displayed in the centre of the screen, Figure 4.6.

Convert NAVETMKZ Data to ASCII Format

Output File I

Format of GPS Positions

Geodetic——————— ~UTH (WGE5S84) Original MMEA Message Convert
 meters " HMEA e
' DDDMM MMMMM et Ly iis

15 Survey feet

Cancel

il

"Folmat of External Sensor - Mot Available ‘

¥ Include Ext. Sensar " Interpreted Data (% [Original Fomat Exit

I
Figure 4.6:  Convert NAV61MK? Files to ASCII Format window

Parameters in Convert NAV61MK2 Data to ASCIl Format Window

Several parameters which affect the contents and format of the created output (ASC)
file must be specified. These are the ASCII file name, and Format of GPS Positions
(coordinates format or original NMEA statement).

Output File

Click on the Output File button. The Select Output File window is displayed
(Figure 4.7).

Select a file name and click the Save button. The Select ASC Output File win-
dow will close and the selected file name will be displayed beside the Output
File (ASC) button in the Convert NAV61MK?2 Files to ASCII Format window.

When Output file is specified the Convert button in the Convert NAV61MK2
Data to ASCII Format window becomes active.
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Select ASC Output File

< A <« Windows (C) » Data > Trm&1MK2 > SRD Site v O 9 Search SRD_Site

Organize »  New folder = @

A Name Type Size

3 Quick access

| Rext18.ASC ASC File 219KB

OneDrive
[ This PC
B 30 Objects
[ Deskiop
[ Documents
¥ Downloads
D Music
&=| Pictures
[ videos
e he

File name; | 201429 -

Save as type: | ASCI Files (*ASC) ~
A Hide Folders Cancel
Figure 4.7:  Select ASC Output File window

Format of GPS Positions

Positions can be written in the output file as geodetic (geographical) coordinates
(Latitude/Longitude), they can be converted to UTM coordinates, or written to
file as original NMEA messages (exactly as streamed by a GPS receiver). The
program uses the WGS1984 datum. To select coordinates click the appropriate
radio buttons in the sections labeled Geodetic or UTM (Figure 4.6).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can
be written in two formats DD.DDDDDDDD or DDMM.MMMMM (native
format found in NMEA GPS messages). To select which format click the appro-
priate radio button in the section labeled Geodetic (Figure 4.6).

UTM coordinates can be generated in meters, feet or US Survey feet. To select
units for UTM coordinates click one of the radio buttons located in the Units
section located at the UTM radio button (Figure 4.6).

Converting NAV61MK2 Data to ASCII Format

When all parameter are set and output file name is specified, the Convert button is
activated in the Convert NAV61MK2 Data to ASCII Format window. After you click

the Convert button, the program begins to read the data, converts data to ASCII format
and writes results to the output file. A progress bar at the bottom of the screen shows the
percentage read (Figure 4.8).
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Convert NAVETMEZ Data to ASCII Format

Qutput File | IC: WDatahT BT ME2YSRD_Siteh2014aa asc
Format of GPS Positions ;
Geodetic—————— ~ UTM [WGE584) Original MMEA Message *

 DDD.DDDODDDD 7 meters % NMEA B
£ DDDMM MMM " feet i |
U5 Survey feet
Cancel |

Exit |

Format of External Sensor - Mot Available
’V ¥ Include Ext Sersor € Interpreted Data % Orniginal Format ‘

Figure 4.8: Convert NAV61MK?2 Files to ASCII Format window
during data processing

The speed of this operation depends on the size of the input file. After the output file
is created the View Converted File button becomes active. Clicking on this button will
display first 63 Kbytes of the created file.

The created file contains EM61 readings, GPS positions, and entire information related
to the instrument and survey settings. Example of the output file in ASCII format is

given in Appendix B.

Clicking Cancel button will clear text box at Output File button. Click on Exit button to
close the Convert NAV61MK?2 Data to ASCII Format window.

4.3 Retrieve and Position Field Comments

The Retrieve and Position Field Comments option allows you to convert retrieve field
comments from NAV61MK?2 binary files. At the same time the program assigns GPS po-
sitions to indicate where these comments were entered by the operator. The position can
be assigned either as a GPS position preceding or position following the comment entry.
The resulting output file consists of coordinates and corresponding text of the comment.
Select Convert | Retrieve and Position Field Comments from the main program menu, as
shown in Figure 4.2.

After the selected menu item is clicked the Position Comments Recorded in
NAV61MK?2 File window will be displayed in the centre of the screen, Figure 4.9.
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Position Comments in NAVETMEK2 Data File

Output File (TXT) | |
Coordinates Format [w/E584) Comment Pogition at——————

Geodetic UTM
’75' ooo.ooooooooD ’7(‘ meters & Last GPS Pasition

" feet
" DDDMM.MMMMBM £ US Survep feet € Nest GPS Postion

Cancel | Exit EiewFilel Eroceed

Figure 4.9:  Position Comments in NAV61MK2 Data window

Parameters in Position Comments Recorded in NAV61MK2 File Window

Several parameters which affect the contents and format of the created output (TXT)
file must be specified. These are the output file names, coordinates format, and indicat-
ing type of position of the comment - using a preceding or following GPS reading.

Output File (TXT)

Click on the Output File (TXT) button. The Select Output File window is dis-
played (Figure 4.10).

Select Qutput File -

4+ <« Data » Trm6IMK2 > SRD_Site v O P Search SRD Site

Organize v New folder f= - (]

A Name Date modified Type Size

# Quick access
5 2011Axt 2021-02-04 7:32 PM Text Document

OneDrive [E 223300t 2021-02-04 7:33 PM Text Document.
[ This PC
3D Objects
[ Desktop
Documents L
& Downlozds
D Music
&= Pictures
1§ Videos v o< >

File name: | Comment2003 ~]

Save as type: | XY Comment Files (T} v
A Hide Folders Cancel
Figure 4.10: Select Output File window

Select a file name and click the Save button. The Select Output File window will
close and the selected file name will be displayed beside the Output File (TXT)
button in the Position Comments Recorded in NAV61MK?2 File window.
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When both, Input and Output files are specified the Proceed button in the Posi-
tion Comments Recorded in NAV61MK?2 File window becomes active.

Coordinates Format

Positions can be written in the output file as geodetic (geographical) coordi-
nates (Latitude/Longitude) or they can be converted to UTM coordinates. The
program uses the WGS1984 datum. To select coordinates click the appropriate
radio buttons in sections labeled Geodetic or UTM (Figure 4.9).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can
be written in two formats DD.DDDDDDDD or DDMM.MMMMM (native
format found in NMEA GPS messages). To select which format click the appro-
priate radio button in section labeled Geodetic (Figure 4.9).

UTM coordinates can be generated in meters, feet or US Survey feet. To select
units for UTM coordinates click one of the radio buttons located in the Units
section located at the UTM radio button (Figure 4.9).

Comment Position at

This section specifies how GPS positions are assigned to the comment. There
are two choices: Comment can be assigned to the last position that was recorded
by the NAV61MK?2 program, or to the position that follows comment entry. In
most cases any choice is right since comments are usually taken while collect-
ing data (including GPS positions) and during comment entry operator stops
recording for a moment. However the option Last GPS Position appears to be
more natural since after the comment entry the operator may stop taking read-
ings and later continue survey from other location.

To select comment position option click one of the radio buttons labeled Last

GPS Position and Next GPS Position located in the Comment Position at sec-
tion of the window (Figure 4.9).

Positioning Comments Recorded in NAV61MK? File

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Position Comments Recorded in NAV61MK?2 File window.
After you click the Proceed button, the program begins to read the input file, converts
data to ASCII format and writes results to the output file. A progress bar at the bottom
of the screen shows the percentage read (Figure 4.11).
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Position Comments in NAVETMEK2 Data File

L

Dutput Fils [TXT) IC: WDatah TrmB1ME2YSRD_Site . Comm_2019 txt

Coordinates Format [w/E584) Comment Pogition at
Geodetic UTM
¢ DOD.DODDDDDDD & meters & Last GPS Pasition
 fest
" DDDMM MMMMMMM U5 Survey fest " Nest GPS Pasition

9 Comments Found Cancel | Exit “iew File

Figure 4.11: Position Comments Recorded in NAV6IMK? File
during data processing

The speed of the operation depends on the size of the input file. After the output file is
created the View File button becomes active. Clicking on this button will display first 63
Kbytes of the created file.

The created file contains GPS positions in the first two columns followed by the text of
comment as recorded in the field. Example of the output file containing comments is
given in Appendix B.

Clicking Cancel button will clear text boxes at Input File (P61) and Output File (TXT)
buttons. Click on Exit button to close the Position Comments Recorded in NAV61MK2
File window.

4.4 Convert GXY Files to XY (ASCII) Format

Files GXY are created by the NAV61MK?2 when only GPS data are collected (EM61 is
Disabled). This type of file contains GPS positions and optionally field comments. The
Convert GXY File to XY (ASCII) Format option allows you to convert GXY binary
file to simple XY type of file. This file contains coordinates placed in first two columns
with optional field comments, elevation, UTC time, local time, and GPS station number
located in following columns. All parameters are always placed in above order. This for-
mat can be viewed with any text editor and it can be easily converted to other formats.

It should be noted that GXY files created with any other Geomar data acquisition
programs (i.e. ML61, NAV61, NAV31, NAV3§, etc.) can be converted to ASCII format
using this option of TrackMaker61MK2.
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Select Convert| GXY Files to XY (ASCII) Format from the main program menu, as
shown in Figure 4.1. After the selected menu item is clicked the Convert GXY File to
XY Format window will be displayed in the centre of the screen, Figure 4.12.

DD Convert GXY or Data File to XY Format

Output File ([DAT)

— Coordinates Format [D atum WGS 1984) [~ Filz Content
Geodetic UTH

¢ DDD.DDDDDDDDD % meters
" Feet

Mumber of Spaces in
Frant of Each Record

=

' DODMM. MMM W Include Field Comments
7 US Survey feet
[T Include Elevation Data
— Elewation W Include UTC [GPS] Time
Elevation Units GPS Anterna Height and Unrits [T Include Local Time
r

Include GPS Stn Mumber

Imeters ;I ID.DD Imeters ;I

v Average Positions at GPS stations [if applicable)
I

G=Y, ATmap, and all M&Y data files, as well az MLET, MLETMEZ, and ML31 data can be processed

Cancel | Exit | EiewFilel Eroceed

Figure 4.12: Convert GXY Files to XY Format window

Parameters in Convert GXY to XY Format Window

Several parameters which affect the contents and format of the created output (DAT)
file must be specified. These are the input and output names, Coordinates Format, and
contents of the output file.

Input File (GXY)

Click on Input File (GXY) button. The Select GXY Input File window is dis-
played (Figure 4.13).

The window lists files with extension name GXY. Select a file name and click
the Open button. The Select GXY File window will close and the selected file
name will be displayed beside the Input File (GXY) button in the Convert GXY
File to XY Format window.
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[ Select GXY or NAVEIMK2 Input File

4 [« Data » Tm6IMK2 » SRD_Site v o 2 Search SRD. Site
Organize ¥ New folder v ™ @
A Name Date modified Tpe Q
s Quick access 1£) 200417_000.P61 204 17 PM P61 File
OneDrive [ 200417_001.P61 P61 File
[ 200417_002.P61 P61 File
[ This PC ] 200417_003.P61 P61 File
7B 30 Objects =] 210204_000.GXY GXY File
B Desktop [ 210204 000.P61 P61 File
Documents E, 210204_001,GXY GXY File
& Dowrloads !;‘, 210204_001.P61 P61 File
y [ 210204 002.GXY GXY File
b Music [ 201808212 P61 P61 File
=] Pictures [E] A1009.P51 P61 File
B videos [E Mod_200416_002.p61 P61 File
i Windows (C) [ TEsT2.pét 2003-02-251233AM  P61File v
v < >
File name: [210204_002.Gi0Y | [6XY or NAVGIMKZ Files (.6xY, ~
Open ||| Cancel
I

Figure 4.13: Select GXY Input File dialog

Output File (DAT)

Click on the Output File (DAT) button. The Select Output File window is dis-
played (Figure 4.14).

A [« Data » TmbIMK2 > SRD Site v o 2 Search SRD, Site
Organize v New folder Bz~ (]
OneDrive A Name Date modified Type Size
] GTR-WE.dat 2, DATFil
[ This PC g ° o
- ] ss20.dat DATFile
¥ 3D Objects
I Deskiop
Documents
4 Downloads
D Music
& Pictures
18 Videos
‘i Windows (C)
v < >
File name: | GTR-SN| =
Save as type: | XY Files (*DAT) v
A Hide Folders Cancel

Figure 4.14: Select Output File dialog

Select a file name and click the Save button. The Select Output File window will
close and the selected file name will be displayed beside the Output File (DAT)
button in the Convert GXY File to XY Format window.

When both, Input and Output files are specified the Proceed button in the Con-
vert GXY File to XY Format window becomes active.
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Coordinates Format

Positions can be written in the output file as geodetic (geographical) coordinates
(Latitude/Longitude) or they can be converted to UTM coordinates. The pro-
gram uses the WGS1984 datum. To select coordinates click appropriate radio
buttons in sections labeled Geodetic or UTM (Figure 4.12).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can
be written in two formats DD.DDDDDDDD or DDMM.MMMMM (native
format found in NMEA GPS messages). To select which format click the appro-
priate radio button in section labeled Geodetic (Figure 4.12).

UTM coordinates can be generated in meters, feet or US Survey feet. To select
units for UTM coordinates click one of the radio buttons located in the Units
section located at the UTM radio button (Figure 4.12).

File Contents

This section affects the output file format and contents. It contains one text box
labeled Number of Spaces in Front of Each Record and five check boxes labeled
Include Field Comments, Include Elevation Data, Include UTC (GPS) Time,
Include Local Time, and Include GPS Stn Number.

Number entered in the text box will specify number of spaces in front of each
record. This option may be useful while using created files as control files in
mapping software. To ignore this option enter zero.

Checking box labeled Include Field Comments will cause the program to write
text of all field comment (entered by the operator during the survey) in to the
created file.

The Include Elevation Data option allows you to place elevation values in the
created file. When this option is checked then a set of options in the frame
labeled Elevation is enabled.

When Include GPS Time box is checked the program will write a column con-
taining time of GPS position, and if the Include Local Time box is checked local
(field computer) time will be written to the file.

When the Include GPS Stn (station) Number is checked then sequential GPS
station will be placed in the file. If averaging was used during GPS data collec-
tion (and check box Average Positions... is not checked) then several recorded
GPS positions may have same station number.
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Elevation

If Elevation check box is checked then window controls associated with Eleva-
tion are enabled. Please select units for elevation values (these can be meters,
feet, or US Survey feet). To obtain ground elevation values please specity GPS
antenna height and units that were used to measure height of the antenna.

Average Positions at GPS stations

If averaging was used during GPS data collection and the check box labeled
Average Positions at GPS stations is checked then the program will calculate av-
eraged position from all readings taken at each station and one resulting value
will be written to the file. When the check box is not checked then all recorded
positions will be placed in the file.

Converting GXY File to XY (ASCII) Format

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Convert GXY to XY Format window. After you click the
Proceed button, the program begins to read the input file, converts data to ASCII format
and writes results to the output file. A progress bar at the bottom of the screen shows the
percentage read (Figure 4.15).

DD Convert GXY or Data File to XY Format

Irput File (G | IE:\Data\TrmE'IMK2\SF|D_Site\2'I 0204_002. Gy

Cutput Fils (DAT) IC: WD atahTrmBTME2VSRD_Site\GTR-SN.dat

— Coordinates Format [D atum WGS 1984) [~ Filz Content
Geadetic UTH IT MNurnber of Spaces in
¢ DDD.OODODDODDD " meters Front of Each Recard

™ feat

" DDDMM. MMM bR W Include Field Comments
& US Survey feet
W Include Elevation Data
— Elewation W Include UTC [GPS] Time
Elevation Units GPS Antenna Height and Units ™ Include Local Time
r

Include GPS Stn Mumber

Imeters ;I I'I 15 Imeters ;I

v Average Positions at GPS stations [if applicable)

346 Posiions Cancel | Ext | wiewFie |

Figure 4.15: Convert GXY Data Files to XY Format window
during data processing
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The speed of this operation depends on the size of the input file. After the output file is
created the View File button becomes active. Clicking on this button will display first 63
Kbytes of the created file.

The created file contains GPS positions as recorded in the field. Example of the output
file in ASCII format is given in Appendix B.

Clicking Cancel button will clear text boxes at Input File (GXY) and Output File (DAT)
buttons. Click on Exit button to close the Convert GXY Files to XY Format window.

4.5 Correct Time Constant Delay in XYZ File

This option allows for the system time constant delay correction. The procedure acts on
two dimensional, GPS positioned data.

While the EM61 time constant is known the time constant of the combined EM61 and
GPS receiver system is a function of these two devices. The easiest method to determine
the time constant of the system is to survey a known buried pipe. After the proper time
constant delay correction is applied the linear anomaly associated with the pipe should
be free of any “hearing bone” effect. Another method to determine the time delay is to
survey a few lines (in two directions) with varying speeds over the same small metallic
target. When displaying the image the anomaly associated with the sample target may
be slightly displaced or extended in size on neighboring lines. After the correct time
constant for the system is determined the anomaly should be at the same location for
each survey line.

Since the image of two dimensional data can be displayed in a mapping system (after
griding) the procedure can be time consuming, however it only needs to be done once
for a given GPS receiver and EM61.

In order to apply the correction the generated XYZ file must have time stamps. In the
event input file does not have time stamp at each reading the program will display a
warning message.

The correction acts on any XYZ type of file so care should be taken that data is not cor-
rected twice.

To access this option select Convert | Correct Time Constant Delay in XYZ File in the
menu (Figure 4.1). The Correct Time Constant Delay window will appear on the screen
(Figure 4.16).

4. Convert Data Files 73



[”] TrackMaker61MEK2 Correct Systern Time Constant Delay in XYZ File

Input File [ I I

Output File I
. Coordinates in v File————
Systemn Time Constant I 04 zeconds & UITM [meters or fest)
t arimurm Gap between Readings I 10 seconds " Geodetic [LATALOM)

Select Input and Output Files Ermea Bdi

Figure 4.16: Correct Time Constant Delay in XYZ File window

Parameters in Correct Time Constant Delay Window

Several parameters which affect the contents of the created output (XYZ) file must
be specified. These are the Input and Output XYZ file names, System Time Constant,
Maximum Gap between Readings, and type of coordinates in the input XYZ file.

Input File

Click on Input File button. The Select Input XYZ File window is displayed
(Figure 4.17).

[I] Select Input X¥Z File

« v 4 [« Data > Tm6IMK2 > SRD Site v o O Search SRD.Site
Organize v New folder =~ @ @
A Name Date modified Type =
# Quick access 1) 200414 _shm_GPS.xyz 2021-02-04 3:56 PM XVZ File
OneDrive ) 200414_shmxoff xyz XVZ File

1] 200414 _shmxoff_GPSayz XVZ File

5 This P 4 200414_shmxoffnoaxyz XVZ File
B 3D Objects 7 200414 _shmxoffno_GPSxyz XVZ File
[ Desktop 7 Co01_geedeticxyz XVZ File
Documents ) co01_geodetic_GPSxyz XVZ File
3 Downloads Tl co0t_UTMmaxyz XVZ File
b Music 1 Coo1_UTMm_GPS.xyz XVZ File
| GTR-5N.dat. DAT File
&) Pictures e )
| GTR-WE.dat DAT File
B videos ) Se14_ Mergedax XVZ File
gedxyz
“ Windows (C) ] Sel4 Merged-2xyz XVZFile v
v o< >
File nome: | CODT_UTMm.xyz | X2 Files (707, <DAT, 850)

Cancel
Figure 4.17: Select Input XYZ File window

The window lists files with extension names XYZ, DAT, and ASC. Select a file
name and click the Open button. The Select Input XYZ File window will close
and the selected file name will appear next to the Input File button in the Cor-
rect Time Constant Delay window.
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Output File

Click on the Output File button. The Select XYZ File window is displayed
(Figure 4.18).

[] Select Output XVZ File X
A |« Data > Tm6IMK2 5 SRD Site v o O Search SRD_Site
Organize v New folder =~ @

A 3
OneDrive Name Type

B This pC 5 2014a3.asc ASC File
- ] 2014M61_V.xyz XVZ File
< 3D Objects ) 2014M61_VSaryz XYZ File
I Desktop ) 200414_metersxyz XVZFile
5] Documents 77 200414_meters GPSxyz XYZ File
& Downloads 7 200414 _shm.xyz X¥Z File
b Music g 200414_shm_GPSaxyz XYZ File
=) Pictures 7l 200414 shimeofayz XV File
B videos 7] 200414_shrmucoff_GPSxyz XVZ File

7 200414 _shmxoffno.xyz
1 200414 shmyoffan GPSxvr

XYZ File

i, Windows (C) 59 P X7 File
v o< >

File name: | MR RN0E
Save as type: | XVZ Files (*XVZ *.DAT, *.ASC) ~

~ Hide Folders Cancel

Figure 4.18: Select Output XYZ File window

As a default the Input File name with prefix C is given. Accept the default, en-
ter, or select a file name and click the Save button. The Select Output XYZ File
window will close and the selected file name will be displayed beside the Output
File button in the Correct Time Constant Delay window.

When Input and Output files are specified the Proceed button in the Correct
Time Constant Delay window becomes active (Figure 4.19).

System Time Constant

Time delay 0.4 seconds is given as a default. This value can be changed (0 to 2
seconds), however the user should experiment before choosing a final value.

Maximum Gap Between Readings

This parameter specifies the maximum time during which the EM61 data will
be treated as continuous data set. If the gap between two stations is larger than
specified maximum gap the station that follows the gap will be assumed the first
station of a new line.

Enter this parameter (in seconds) in the edit box labeled Maximum Gap be-
tween Readings. In most cases a value 2 to 3 times larger than the GPS acquisi-
tion frequency is adequate.
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Coordinates in XYZ File

Specity type of coordinates in the input file. The output file will be written with
the same type of coordinates.

Creating XYZ File With Time Delay Corrections

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Correct Time Constant Delay window. After you click the
Proceed button, the program begins to read and analyze the input file. A label Analyzing
File is displayed at the bottom of the window. The program then calculates corrections
for each station based on the instant velocity of the system at each station. A progress
bar at the bottom of the screen shows the percentage read (Figure 4.19).

[I[] TrackMaker61MK2 Correct System Time Constant Delay in XYZ File

Input File | IE:\Data\TrmB1MK2‘\SHD_Site\EDDLUTMm.:@z
Output File | IE:\Data\TrmE‘IMK2‘\SF|D_Site\EEDD‘I_LITMMX\’Z

Systemn Time Constant I 035  seconds "Enordmates i &I

& LUTH [meters or feet)
" Geodetic [LAT ALOM]

taximum Gap between Readings I 10 seconds

Calculates comections. .

Figure 4.19: Correct Time Constant Delay in the XYZ File
window during data processing

If the input file does not contain time stamp information, the program will display a
warning message, and it will pause operation till the OK button is clicked in the warning
window.
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Nave1MK2 Data File

A.1 Description of Nav61MK2 Data File Format (P61)

Each record created by the Nav61MK2 program contains 27 characters, including line
feed at the end of each record.

Header of the file contains 7 records starting with characters R, H, G, and then four
records starting with O.

12 3 4 5 6 7 8 9 10 1112 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27
NAV MK 2 W 2 1 5 |SurveyType |[UT| IT|IM]|ST DD 10
H File Name Reading Time Increment TG 10
G| GPSXOfset F7.3) | GPSYOfisetF7.3) Ra|cl| |st|cPlGs 10
0 Offset for Ch1 (F9.2) 10
o] Offset for Ch2 (F9.2) 10
) Offset for Ch3 (F9.2) 10
O| Offsetfor Ch4 (or T) (F9.2) 10
NAVMK?2 - identification of program file for Standard model,
and NAVMKZ2H for High Power, see also ST
W215 - Nav6o1MK2 version number (V2.15)
Survey Type - GPS (if GPS Input Enabled) or GRD (grid)
uUT - unit type (0 = meters, 1 = ft, 2 = US Survey ft)
IT - sensor size
O0=1x1m,1=1x05m,2=05x0.5m)
M - not used in this version (0 = Auto mode)
ST - instrument type (=0 standard, =1 High Power,
=2 Standard N.C.C, =3 High Power N.C.C.)
DD - display decimation factor (not used)
File Name - file name, maximum 8 characters
Time - this field depends on EM61-MK?2 survey mode

Auto Mode - Time Increment in seconds
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TG - File tag (space=original, 1=Saved As / edited)

GPS X Offset - Offset of GPS antenna in X direction

GPS Y Offset - Offset of GPS antenna in Y direction

RQ - Request Char. Model (= 1 Yes, 0 or Space - No)
CI - program type (= 7 fixed - Windows 10 or 7)

SL - SLAM option (=1 Yes, =0 or Space - No)

GP - type of GPS NMEA message

(0 = GGA/GSA, 1= GGA, 2 = POS, 3 = LLK,
4=LLQ, 5=GLL, 6=GGK, 7=pGGA, 8=pGLL)

GS - GPS state (O=disabled, 1=Enabled, >1 indicates
averaging number for GXY files)

0] - nulling value for corresponding channel

10 - Line Feed character

Header at the start of survey line (contains four records starting with L, B, A, and Z)

23 45 6 7 8 9 1000 12 13 14 05 106 17 18 19 2021 22 23 24 25 26 1

|
L Line Name - 8 characters 10
B Start Station (Format F11.2) 10
A |Dir Increment  (Format F11.3) 10
ZIDDMMY Y Y Y HH  : MM : S S . h h 10

Line Name - Line Name, maximum 8 characters

Start Station - Start Station for the Line, format F11.2

Time - Time when Line was created in milliseconds

Dir - Direction of the Line (E, W, N, or S)

Station Inc. - Station Increment, format F11.3

Date - Date when Line was created, format DD-MM-YYYY

Time - Time when Line was created, format HH:MM:SS.hh

10 - Line Feed character

Timer Reset

12 3 4 5 6 7 8 9 00101 1213 14105706 17 18 19 20 21 22 23 24 25 2 77

* | Computer Time (Format HH:MM:SS.hh) Time Stamp in ms (10 digits) 10

Indicates reset time of the program timer. This record links timer in millisec-
onds and computer time (local time) in format HH:MM:SS.hh. This record is
written to the file each time after the program switches from the Stand By to
Log mode. In case when data are taken continuously the timer is automatically
reset every hour.
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Reading

12 3 4 5 6 7 8 9 1011 12 13 1415 16 17 18 19 20 21 22 23 24 25 26 1
I |Gn| Th 11| 2h 2I|3h 31 |4h 4l |5h 51 |6 |7h 71| 8 Time Stamp in ms (10 digits) | 10
I - indicator (one ASCII character). Number of the ASCII character rep-
resents type of reading (standard or Hand Held sensor and Mode 4 or
D), and presence of fiducial marker.
84 - Standard, Mode 4, channels 1, 2, 3, 4
68 - Standard, Mode D, channels1,2,3, T
69 - Hand Held, Mode 4, channels 1, 2, 3, 4
70 - Hand Held, Mode D, channels1,2,3, T
77 - Standard, Mode 4, channels 1,2,3,4  Marker
78 - Standard, Mode D, channels1,2,3, T Marker
80 - Hand Held, Mode 4, channels 1,2,3,4  Marker
81 - Hand Held, Mode D, channels1,2,3, T Marker
Gn - one character parameter (Hex format), contains Gain, see table of
ranges at the end of this section.
1h - higher byte of the 2’s complement Hex number of Channel 1
11 - lower byte of Channel 1
2h - higher byte of the 2’s complement Hex number of Channel 2
21 - lower byte of Channel 2
3h - higher byte of the 2’s complement Hex number of Channel 3
31 - lower byte of Channel 3
4h - higher byte of the 2’s complement Hex number of Channel 4
41 - lower byte of Channel 4
5h -  higher byte of the 2’s complement Hex number of TX averaged current
51 - lower byte of TX averaged current
6 - fraction of averaged current (Sh 51), Hex number
7h - higher byte of the 2’s complement Hex number of TX current
71 - lower byte of TX current
8 - instrument battery voltage, Hex number
Time - time stamp of the reading in milliseconds, this is time elapsed from the
start (creation) of the current data. The time in milliseconds can be
linked with the computer local time by using Times in lines B and Z of
Line Header.
10 - Line Feed character
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Comment

12 3 4 5 6 7 8 9 10010 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 17
C Comment (maximum 11 characters) Time Stamp in ms (10 digits) 10
New Station
12 3 4 5 6 7 8 9 1010 1213 14 15 16 17 18 19 20 21 22 23 24 25 26 17
S New Station (Format 11.2) Time Stamp in ms (10 digits) 10
Internal Readings
12 3 4 5 6 7 8 9 1010 1213 14 15 06 17 18 19 20 21 22 23 24 25 26 1]
{|a Internal Position of an Element (Format 14.3) Time Stamp in ms (10 digits) 10
These records (curly brackets) are used only internally during data collection to speed
up map re-drawing in real time.
Records starting with X
Several informative records, for example X$§STARTED indicates start of Logging mode,
X$PAUSED indicates Pause (activated by Pause key stroke), etc.
GPS Data Message Records
Each GPS record (NMEA Message) is broken in to several 25 characters strings and
placed in the Nav61MK?2 data file which contains 27 characters records, including one
character indicator and line feed at the end of each record. The GPS sequence starts at
the line which contains the character @ as the first character, then records that contain
a continuation of the same message start with the character #. The GPS sequence ends
with a line starting with the character !. The last line contains sequential number of GPS
recorded position and a logger time stamp for the given GPS reading. A sample of the
GGA (one of GPS messages) written in Navo1MK2 format is given below.
12 3 4 5 6 7 8 9 101012 13 141516 17 18 19 20 21 22 23 24 25 26 17
@|S|G|IP|G|G|A|, |h|hIm[m|s|s|.|s|s |, |d|d[m[m]|. [m|[m|[m]l0
#lmm|, |s|, [dld|d|{m|{m|[.|m|m[m|{m|[m|,|[s|,|n]|,|qlqg|,|p]|l0
#|p pl,|slalalalalal.lalal,[ul,|E£|x]|x|x|[x|.|x]|,|[M][I0
#| ,|s|s|s|,|lalalal*|c]|c]|CRILF 10
F[O|O0|4|3]5 Time Stamp in ms (10 digits) 10
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The GPS sequence may contain 4 to 7 records. The components of the GGA message
may differ in length, however they are placed in the same number of columns. Refer to
Appendix B (section B.2) for the definition of each component of the GGA data mes-
sage. Other available GPS messages in NMEA format, GSA, POS, LLK, LLQ, GLL,
and GGK, are recorded similarly. The structure of these NMEA sentences is given in
section B.2 of Appendix B.

If the Checksum in NMEA message is invalid then starting character @ is replaced by ?,

and # is replaced by " (ASCII character code 34). The starting character of Time Stamp
record ! remains the same.

A.2 Conversion Factors

EM61-MK2 has four channels. Channels 1, 2, and 3 are common for Mode 4 and Mode
D. Channel 4 in Mode D is named Channel T (it corresponds to Top coil).

The instrument response is converted to output voltage in mV for each sampling chan-
nel as given below.

Channel 1to 4 - converted data
DATA (1to4) - instrument output for each channel as recorded in logger
RANGE - range is controlled by the EM61-MK?2, it can be 1, 10, or 100

EM61-MK2 -Mode 4 (One Sensor 1 x0.5mor 1x1m)
Channel 1=(DATA1 x 4.8333 x 2)/RANGE
Channel 2=(DATA2 x 4.8333 x 2)/RANGE
Channel 3=(DATA3 x 4.8333 x 2)/RANGE
Channel 4=(DATA4 x 4.8333 x 2)/RANGE

EM61-MK2 -Mode D (Two Sensors 1 x 0.5 m or 1 x 1 m, Top and Bottom coils))
Channel 1=(DATA1 x 4.8333 x 2)/RANGE
Channel 2=(DATA2 x 4.8333 x 2)/RANGE
Channel 3=(DATA3 x 4.8333 x 2)/RANGE
Channel T=(DATA4 x 4.8333 x 4)/RANGE
if coil is 1 x 0.5 m Channel T is further multiplied by a factor 1.117.

Further each channel is normalized by current following formula:

EM61-MK2 Channel = Channel x 3000/Current
where, current is a value represented by 5h, 51, and 6 in reading
record of Nav61MK?2 data file (see section A.1)
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Table of Ranges Determined by the EM61-MK2 Microprocessor

HEX| Ch1 Ch2 Ch3 Ch4| |HEX |[Ch1 Ch2 Ch3 Ch4||HEX| Ch1 Ch2 Ch3 Ch4
o |1 1 1 1 40 |10 1 1 1 co | 100 1 1 1
1 1 1 1 10 41 10 1 1 10 C1 100 1 1 10
3 |1 1 1 100| [43 |10 1 1 100{ |C3 | 100 1 1 100
4 |1 1 10 1 44 |10 1 10 1 c4 | 100 1 10 1
5 |1 1 10 10 45 |10 1 10 10 c5 | 100 1 10 10
7 |1 1 10 100| (47 |10 1 10 100( |C7 | 100 1 10 100
c |1 1 100 1 4C |10 1 100 1 cC | 100 1 100 1
D |1 1 100 10 4D |10 1 100 10 Ch | 100 1 100 10
F |1 1 100 100( |4F |10 1 100 100( [CF | 100 1 100 100
10 | 1 10 1 1 50 |10 10 1 1 DO | 100 10 1 1
11 1 10 1 10 51 10 10 1 10 D1 100 10 1 10
13 | 1 10 1 100 [53 |10 10 1 100( |D3 | 100 10 1 100
14 |1 10 10 1 54 |10 10 10 1 D4 | 100 10 10 1
15 | 1 10 10 10 55 |10 10 10 10 D5 | 100 10 10 10
17 |1 10 10 100| |57 |10 10 10 100( |D7 | 100 10 10 100
1C | 1 10 100 1 5C |10 10 100 1 DC | 100 10 100 1
iD | 1 10 100 10 5D |10 10 100 10 DD | 100 10 100 10
1F | 1 10 100 100 |5F |10 10 100 100( [DF | 100 10 100 100
30 |1 100 1 1 70 |10 100 1 1 FO | 100 100 1 1
31 1 100 1 10 71 10 100 1 10 F1 100 100 1 10
33 |1 100 1 100| (73 |10 100 1 100( |F3 | 100 100 1 100
34 |1 100 10 1 74 |10 100 10 1 F4 | 100 100 10 1
35 |1 100 10 10 75 |10 100 10 10 F5 | 100 100 10 10
37 |1 100 10 100| |77 |10 100 10 100( |F7 | 100 100 10 100
3C |1 100 100 1 7C |10 100 100 1 FC | 100 100 100 1
3D |1 100 100 10 7D |10 100 100 10 FD | 100 100 100 10
3F |1 100 100 100| (7F (10 100 100 100| |FF | 100 100 100 100
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A.3 Example of Nav61MK2 Data File

The Nav61MK?2 data file records are written in binary format, therefore characters may
have a different shape when displayed or printed, depending on particular video or
printer settings.

NAVMK2 W206GPSOOOO 1

H200327 001 0.100 0
G 0.000 0.0001 10

0 694.05

0 342.40

0 185.74

0 79.72

Lo

B 0.00

AS 1.000
724022006 22:51:08

0 694.05 0.00

0 342.40 0.00

0 185.74 0.00

0 79.72 0.00
*22:51:08.000 321892745
@$GPGSA,A, 3, ,,23,25 20 16
#14 06,01,,,02.2,01.2

8*09
321894566
DyOnB -1 $* <0 321894763

DyQ
y g T¢O 321894964

by
¥ $Y,f0 321895165

¥ ;fO Bi t~ 0 321895366
odabGan 055055 00,4336.593
#76 0%936 65029, W,2,71,

s sSLE s e
@$GPGSA A,3,,,23,25 20
bé v0i,,,02.%,01.2
321895544

Dygg ¢/ X 10 321895567
a ¢§ 30 321895768
¥ "0 321895969

D3

ﬁ 10 321§9517o

¥ y SO 321896371

@$GPGGA 055056 00,4336.593

#90 07936 65024, 2,7,1,
39.97,M M,6,119%55

@ GPGSA,A,3,,,23,25 20 16
$éé 01%1765%5%51°9

321896543
DyR

-/ 0 321896572
DyQ‘X p0 " 80 321896773
gyo”

" 0 321896974
Dg g3e

- 80 321897175
DySA6s T a <0 321897376
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A.4 Format of GXY Data File

The Nav61MK2 data file with extension GXY contains GPS records. The structure of
this file is identical to the standard Navo1MK2 (P61) file. The difference is that it does
not contain any EM61-MK?2 records. This file is created by Navo1MK2 when the EM61-
MK?2 option is Disabled in the System Setup menu. In this case the program acts as a
GPS logging program.

It should be noted that any Navo1MK2 data file, as well as GXY and data files cre-
ated by other Geomar data acquisition programs (RTmap31, NAV31, NAV61MK2,
ML61MK2xpn, etc.) can be used as an GXY file in the data processing programs
TrackMaker61MK2. The extension name GXY indicates that the file does not contain
electromagnetic data.
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File Formats

B.1 Description of Geonics DAT61MK2 (M61) File Format

A DAT61MK?2 (with extension name M61) ASCII data file is comprised of one file
header, one or more line header, one or more station records after each line header and
GPS info (if GPS was used during data acquisition). The file starts with a file header. In
the body of file there are line headers and station records. Line header, station record
and GPS info can be distinguished by a type of id which is the first character in each
record.

File Header starts and ends by a double line separators and it contains three lines, as
shown below:

=============== EM6IMK2 FILE HEADER ===============
EM6IMK2 V1.00GPSUIM

FileName Timel

Channel 1 Channel 2 Channel 3 Channel 4

First line contains following parameters:

EM61IMK2 - identification of program file

V120 - version number (V1.20)

Survey Type - GPS (if GPS Input Enabled) or GRD (grid)

U - unit type (0 = meters, 1 = feet)

1 - instrument type
(0 = sensor 1x0.5m, 1 = 1x1m, 2 = 0.5x0.5m,
3 = HH61)

M - instrument mode (0 = Auto, 1 = Wheel, and
2 = Manual)

Second Line contains file name and time increment if Auto Mode was used:

File Name - file name, maximum 8 characters

Time Increment - time increment (if Auto Mode was used) in
seconds
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The last line of file header contains offsets for each channel that were used during data
acquisition:
Offsets - four values for channel 1, 2, 3, and 4 respectively.

Line Header contains four lines, each line starts with identifier id as shown below:

L LineName FileName GPS U I M

B Start
A D StationIncrement
Z Date Time

The first line of Line Header starts with L and contains:

Line Name - line name, maximum 8 characters

File Name - file name, maximum 8 characters (original file for this
line)

Survey Type - GPS (if GPS Input Enabled) or GRD (grid)

U - unit type (0 = meters, 1 = feet)

I - instrument type
(0 = sensor 1x0.5m, 1 = 1x1m, 2 = 0.5x0.5m,
3 = HH61)

M - instrument mode (0 = Auto, 1 = Wheel,

and 2 = Manual)
Second line starts with B and contains Start Station for the Line, format F11.2

The third line starts with A and contains:
Dir - Direction of the Line (E, W, N, or S)
Station Inc. - Station Increment, format F11.3

The fourth line starts with Z and includes:
Date - Date when Line was created, format MM-DD-YYYY
Time - Time when Line was created, format HH:MM:SS

Each reading starts with indicator id specifying type of the data. The indicator is fol-
lowed by six columns: Station, Channel 1, Channel 2, Channel 3, Channel 4 or T, and
Time Stamp.
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id

indicator T, D, E, E M, N, P, or Q. Each record representing

reading starts with one of the following character, which

indicates type of reading:

- Standard, Mode 4, channels 1,
- Standard, Mode D, channels 1,
- Hand Held, Mode 4, channels 1,
- Hand Held, Mode D, channels 1,
Standard, Mode 4, channels 1,
- Standard, Mode D, channels 1,
- Hand Held, Mode 4, channels 1,
- Hand Held, Mode D, channels 1,

ocmzZzmET =
NSENSEN RO RN R RN
wwwwuwwww
HEdrgegs

+Marker
+Marker
+Marker
+Marker

Reading containing GPS data starts with character @. This character is followed by eight

columns separated by commas.

Column 1 - UTC time in hours, minutes, seconds of the GPS position

Column 2 - Latitude (ddmm.mmmmm) in degrees, minutes, and decimal
minutes

Column 3 - N for North or S for South latitude

Column 4 - Longitude (dddmm.mmmmm) in degrees, minutes, and
decimal minutes

Column 5 - W for West or E for East longitude

Column 6 - Quality indicator, 0 = no position, 1 = raw (GPS),

2 = differentially corrected position (DGPS),

3 = RTK, 4 = Code Phase Only
Column 7 - Number of satellites used in position computation
Column 8 - Field computer time

For more informations regarding GPS parameters refer to Appendix B of the
NAV61MK2 manual.
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Example of DAT61MK2 File

EM61MK2 V1.20 GPS 0 2 0

EM61MK2 FILE HEADER

022623A 1 0.250
-1087.69 -707.90 -378.35 -168.02
L 102 022623A GPS 0 2 0
B 332.00 0
AW 1.000

Z 02/26/2002 23:59:03

@,051101.
E 332.
333.
334.
,051102.
335.
336.
337.
,051103.
338.
339.
340.
341.
,051104.
342.
343.
344.
,051105.
345.
346.
347.
,051106.
348.
349.
350.
,051107.
351.
352.
353.
,051108.
354.
355.
356.
,051109.
357.

(e I I o B I o I T o I c B s IR B s IO o I s I I o I s O o I T o O o I o I B s O o B s I o I T o B o I o I R 5 I o

00,4336.59257,N,07936.
00 102.65 112.
00 112.24 107.
00 135.44 114.
00,4336.59257,N,07936.
00 138.67 102.
00 127.49 120.
00 110.63 133.
00,4336.59257,N,07936.
00 115.39 128.
00 120.10 102.
00 113.46 138.
00 114.28 130.
00,4336.59255,N,07936.
00 116.97 136.
00 123.37 103.
00 103.80 106.
00,4336.59250,N,07936.
00 133.68 113.
00 122.31 108.
00 123.32 103.
00,4336.59248,N,07936.
00 111.04 112.
00 152.32 107.
00 128.25 116.
00,4336.59250,N,07936.
00 123.58 108.
00 112.02 117.
00 127.77 90.
00,4336.59250,N,07936.
00 118.30 94.
00 143.09 93.
00 124.63 118.
00,4336.59251,N,07936.
00 134.12 120.

65004,

36
84
72

65005,

66
12
76

65008,

53
35
90
08

65006,

68
47
45

65008,

31
70
15

65009,

19
07
60

65000,

23
47
24

65001,

10
08
26

65002,

75

W,2,8,2,23:59:04.378
81.00 71.76 23:59:04.566
71.14 67.23 23:59:04.870
80.37 70.85 23:59:05.171
W,2,8,2,23:59:05.378
85.52 63.74 23:59:05.504
84.50 71.75 23:59:05.955
100.53 71.45 23:59:06.245
W,2,8,2,23:59:06.370
75.45 76.12 23:59:06.561
99.17 65.99 23:59:06.812
93.98 70.52 23:59:07.113
81.69 66.59 23:59:07.415
W,2,8,2,23:59:07.419
75.19 72.02 23:59:07.704
87.65 74.59 23:59:08.007
75.66 82.90 23:59:08.313
W,2,8,2,23:59:08.379
89.55 63.24 23:59:08.613
79.38 92.57 23:59:08.874
84.96 77.44 23:59:09.164
Ww,2,8,2,23:59:09.378
72.24 59.90 23:59:09.563
84.50 68.20 23:59:09.855
84.48 77.73 23:59:10.154
wW,2,8,2,23:59:10.377
79.79 60.93 23:59:10.554
87.28 56.54 23:59:10.805
84 .32 66.51 23:59:11.202
wW,2,8,2,23:59:11.379
75.16 82.39 23:59:11.560
97.17 74.82 23:59:11.862
79.18 64.83 23:59:12.152
W,2,8,2,23:59:12.380
65.24 64.21 23:59:12.551
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B.2 Description of NAV61MK2 File in ASCII Format

The NAV61MK?2 data file converted to ASCII format is similar to file in DAT61MK2
however it contains additional information related to multiple instruments which is not
supported by DAT61MK2 format. The format of the file is self explanatory.

The file starts with a header block, which starts with the line NAVMK2 File Header and
it ends with line End of file header. The file header includes: NAV61MK?2 version num-
ber, type of positioning, distance units, sensor type, survey mode, name of data file (as
entered during the survey), GPS Antenna location, GPS NMEA message type, sensor
separation, and offsets for all instruments.

The file contains at least one survey line (even if survey lines are not used with GPS
positioning). Each survey line starts with a Line Header Block. The Line Header Block
contains four lines describing: survey line name, start station, station increment, date
(MM/DD/YYYY) and time (HH:MM:SS) of line creation.

Lines containing readings start with one of the reading indicators: T, D, E, F, M, N, P,
and Q. These reading indicators are described in section B.1 of this Appendix. Reading
identifier is floowed by six columns: station number, Channel 1, Channel 2, Channel 3,
Channel 4 (or T), and local time stamp (format HH:MM:SS.ttt).

Line that starts with C corresponds to field comment, and line that starts with N indi-
cates entry of New Station.

GPS data consists of one or two lines starting with GP and GQ. Line containing GP is
always present and it contains position, while line starting with GQ corresponds to qual-
ity of GPS reading.

Line that starts with GP contains position, UTC time, and local time. If Geodetic Coor-
dinates were selected the position is indicated by Latitude and Longitude. In case when
UTM coordinates were selected the position is described by UTM Zone number, East-
ing and Northing (see example of the file below). The second line that starts with GQ
describes quality of GPS position and it contents depends on the NMEA message used
during the survey. In the example of the file GQ statement is given for NMEA message
pair GGA/GSA and contains: Position Quality, status of differential corrections, and
index PDOP. For other NMEA messages contents of line starting with GQ may differ.

Line containing GPS position may also include original NMEA message if this option
was selected in Convert NAV61MK?2 File to ASCII Format window.
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Examples of NAV61MK? files in ASCII format

NAV61MK2 File Header
Positioning: GPS

Sensor Type: Hand Held
Data File 041710B.P61
GPS Message : GGA/GSA

GPS Antenna Position
GPS X offset: 0.00
GPS Y offset: 0.00

Offsets:

EM61 Chl 0.00

EM61 Ch2 0.00

EM61 Ch3 0.00

EM61 Ch4/T: 0.00
End of file header
Survey Line : 0
Start Station 0.00
Station Increment: 1.000
Date: 04/17/2002 Time: 10:56:57
HH-4 0.000 103.92 47.
HH-4 1.000 100.67 45.
HH-4 2.000 97.44 45.
GP 79.610852167,W, 43.609896000,N,
GQ Position: 3D Differential (DGPS)
HH-4 3.000 97.05 44
HH-4 4.000 94.44 43.
HH-4 5.000 95.28 44
HH-4 6.000 93.38 43.
HH-4 7.000 93.01 42
GP 79.610851000,W, 43.609900000,N,
GQ Position: 3D Differential (DGPS)
HH-4 8.000 91.60 40
HH-4 9.000 92.75 41
HH-4 10.000 91.08 40.
HH-4 11.000 90.80 41
HH-4 12.000 88.55 40.
GP 79.610850500,W, 43.609905000,N,
GQ Position: 3D Differential (DGPS)
HH-4 13.000 87.86 39.
HH-4 14.000 87.38 40
HH-4 15.000 86.98 39.
HH-4 16.000 86.55 40.
HH-4 17.000 85.16 39.
GP 79.610850500,W, 43.609909833,N,
GQ Position: 3D Differential (DGPS)
HH-4 18.000 84.78 39.
HH-4 19.000 85.51 37.
HH-4 20.000 85.68 38.
HH-4 21.000 85.75 37.

Version V1.00

Distance units:

Survey Mode

29
23
77

15:

.13

70

.14

42

.94
15:

.38
.12

63

.41

41

15:

09

.22

46
74
39

15:

20
95
48

meters
: Auto
24.45 12.66 10:57:00.949
22.20 11.95 10:57:01.150
24.17 12.79 10:57:01.347
56:32.00 10:57:01.351
PDOP: 02.3 10:57:01.351
24.17 12.79 10:57:01.546
22.20 11.43 10:57:01.743
22.52 12.26 10:57:01.946
20.39 11.62 10:57:02.146
21.71 12.87 10:57:02.347
56:33.00 10:57:02.351
PDOP: 02.3 10:57:02.351
21.08 11.28 10:57:02.546
21.80 12.10 10:57:02.745
20.36 10.70 10:57:02.896
20.07 11.24 10:57:03.146
20.79 10.62 10:57:03.345
56:34.00 10:57:03.355
PDOP: 02.3 10:57:03.355
20.08 11.51 10:57:03.546
19.95 11.43 10:57:03.722
19.03 11.18 10:57:03.921
20.37 10.43 10:57:04.120
19.88 9.89 10:57:04.321
56:35.00 10:57:04.330
PDOP: 02.3 10:57:04.330
20.75 9.89 10:57:04.502
19.14 9.99 10:57:04.728
19.27 10.80 10:57:04.927
18.26 10.70 10:57:05.127
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NAV61MK2 File Header Version V1.00

Positioning: GPS Distance units: meters
Sensor Type: Hand Held Survey Mode : Auto
Data File : 050808A.P61

GPS Message : GGA/GSA

GPS Antenna Position
GPS X offset: 0.00
GPS Y offset: 0.00

Offsets:
EM61 Chl 68.25
EM61 Ch2 50.29
EM61 Ch3 12.98
EM61 Ch4/T: 32.64

End of file header

Survey Line H

Start Station : 0.00

Station Increment: 1.000

Date: 05/08/2002 Time: 08:32:27
$GPGGA,154129.00,4339.97271,N,07938.91285,W,2,8,1,168.38,M,-35,M,6,119*5B 08:33:48.988

$GPGSsA,A,3,30,,04,24,20,13,,,07,05,01,,02.1,01.4,01.6*01 08:33:48.988

STD-D 0.000 43.28 77.31 58.10 77.85 08:33:49.198

STD-D 1.000 43.05 78.30 58.25 76.83 08:33:49.397

STD-D 2.000 42.97 77.23 57.26 75.31 08:33:49.597

STD-D 3.000 42.97 75.94 58.40 78.36 08:33:49.796

STD-D 4.000 43.12 76.62 57.79 75.47 08:33:49.996
$GPGGA,154130.00,4339.97326,N,07938.91261,W,2,8,1,168.84,M,-35,M,4,119*5F 08:33:50.044
$GPGsA,A,3,30,,04,24,20,13,,,07,05,01,,02.1,01.4,01.6*01 08:33:50.044

STD-D 5.000 40.30 75.32 56.26 73.43 08:33:50.197

STD-D 6.000 36.79 73.64 57.02 75.63 08:33:50.398

STD-D 7.000 36.86 73.33 56.33 72.40 08:33:50.597

STD-D 8.000 34.49 70.43 54.65 68.32 08:33:50.796

STD-D 9.000 28.63 67.07 54.57 66.79 08:33:50.997
$GPGGA,154131.00,4339.97340,N,07938.91232,W,2,8,1,168.75,M,-35,M,5,119*57 08:33:51.045
$GPGSsA,A,3,30,,04,24,20,13,,,07,05,01,,02.1,01.4,01.6*01 08:33:51.045

STD-D 10.000 24.89 66.23 52.67 59.16 08:33:51.198

STD-D 11.000 20.93 63.26 50.23 52.88 08:33:51.397

STD-D 12.000 19.33 61.66 51.22 54.74 08:33:51.597

STD-D 13.000 19.33 62.04 50.46 51.18 08:33:51.797

STD-D 14.000 17.81 61.36 49.24 53.05 08:33:51.997
$GPGGA,154132.00,4339.97356,N,07938.91228,W,2,8,1,168.77,M,-35,M,6,119*59 08:33:52.045
$GPGSsA,A,3,30,,04,24,20,13,,,07,05,01,,02.1,01.4,01.6*01 08:33:52.045

STD-D 15.000 16.36 59.75 49.62 53.38 08:33:52.197

STD-D 16.000 14.45 58.00 48.25 51.34 08:33:52.397

STD-D 17.000 7.75 52.97 45.20 48.80 08:33:52.597

STD-D 18.000 -0.86 48.25 43.75 49.48 08:33:52.796

STD-D 19.000 -7.48 43.68 39.64 44.73 08:33:52.996
$GPGGA,154133.00,4339.97354,N,07938.91194,W,2,8,1,168.75,M,-35,M,5,119*5F 08:33:53.045
$GPGSsA,A,3,30,,04,24,20,13,,,07,05,01,,02.1,01.5,01.6*00 08:33:53.045

STD-D 20.000 -20.88 32.94 33.78 40.15 08:33:53.197

STD-D 21.000 -36.65 23.04 28.45 36.24 08:33:53.398

STD-D 22.000 -51.04 13.98 25.02 32.68 08:33:53.597

STD-D 23.000 -59.04 7.74 19.46 27.09 08:33:53.797

STD-D 24.000 -69.54 0.58 15.27 24.54 08:33:53.996
$GPGGA,154134.00,4339.97374,N,07938.91173,W,2,8,1,168.78,M,-35,M,6,119*5D 08:33:54.045
$GPGSsA,A,3,30,,04,24,20,13,,,07,05,01,,02.1,01.5,01.6*00 08:33:54.045

STD-D 25.000 -80.05 -6.12 12.84 21.32 08:33:54.199

STD-D 26.000 -87.67 -11.22 8.57 16.90 08:33:54.398

STD-D 27.000 -95.82 -16.40 5.60 15.21 08:33:54.597

STD-D 28.000 -101.45 -20.51 4.69 14.36 08:33:54.798
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B.3 NAV61MK2 GXY File in ASCII Format

The GXY type of file while converted to ASCII format with extension name DAT
consists of coordinates in UTM or Geodetic format. While in UTM format Easting
coordinate is located in the first column and Northing in the second column. If Geodetic
format was selected then Longitude is written in the first column and Latitude in the sec-
ond column. Optionally the file may include GPS UTC time and text of field comments.

Example of GXY file in ASCII format (UTM coordinates)

612102.229 4829484.278 01:59:17.00
612102.255 4829484.352 01:59:18.00
612102.241 4829484.389 01:59:19.00
612102.349 4829484.391 01:59:20.00
612102.268 4829484.408 01:59:21.00
Comment: “Stake #3”
612102.578 4829484.339 01:59:32.00
612102.564 4829484.376 01:59:33.00
612102.578 4829484.339 01:59:34.00
612102.579 4829484.284 01:59:35.00
612102.718 4829484.045 01:59:36.00
Comment: “bldg corner”
612102.730 4829484.101 01:59:53.00
612102.784 4829484.121 01:59:54.00
612102.853 4829483.992 01:59:55.00
612102.813 4829483.973 01:59:56.00

Example of GXY file in ASCIl format (Geodetic coordinates)

-79.610841500 43.609900500 01:59:17.00
-79.610841167 43.609901167 01:59:18.00
-79.610841333 43.609901500 01:59:19.00
-79.610840000 43.609901500 01:59:20.00
-79.610841000 43.609901667 01:59:21.00
Comment: “Stake #3”
-79.610837167 43.609901000 01:59:32.00
-79.610837333 43.609901333 01:59:33.00
-79.610837167 43.609901000 01:59:34.00
-79.610837167 43.609900500 01:59:35.00
-79.610835500 43.609898333 01:59:36.00
Comment: “bldg corner”
-79.610835333 43.609898833 01:59:53.00
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B.4 Retrieved and Positioned Field Comments

File containing retreived and positioned comments starts with a header indicating name
of the original NAV61MK?2 data file. This is followed by coordinates and text of com-
ment enclosed in double quotes. Coordinates can be written in UTM or Geodetic for-
mat. Column one includes Easting or Longitude, and second column contains Northing
or Latitude. The optional, fourth column of the file includes local time.

Example of file containing positioned comments (Geodetic coordinates)

Comments in Data File : 052818A.P61
-79.610851833 43.609890333 “Stake#10” 18:17:41.934
-79.610850500 43.609890167 “Stake#20” 18:29:32.187
-79.610833500 43.609879500 “Stake#30” 18:29:36.834
-79.610833500 43.609879500 “Stahe#40” 18:29:41.974
-79.610833500 43.609879500 “WoodPile” 18:29:47.636
-79.610835167 43.609885833 “Sm Tree ” 18:37:11.833

B.5 Output File (XYZ)

The output XYZ file may be written in two output formats: Generic and Geosoft type of
XYZ file. The only difference between these two formats is that Geosoft format contains
line labeled Line # at the beginning of each survey line.

Coordinates can be written in UTM or Geodetic format. Column one includes Easting
or Longitude, and second column contains Northing or Latitude. The optional column
that includes a reading time stamp (local time) is always placed as the last column in the
file.

All lines containing description text start with character “\” with the exception of label
Line# if Geosoft data type is used. If the Include Header Info option was used then
each file contains header fully describing XYZ file contents. See the example of the
XYZ file given below. This sample file is in UTM coordinates and it contains elevation
data.
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Example of XYZ file created by TrackMaker6 1MK2

/ UTM zone = 16, Datum: WGS1984

/ Easting [USft], Northing [USft], Chl[mV], Ch2[mV], Ch3[mV], Ch4[mV], ChD[mV], Elev.[ft], Quality, Sat., HDOP, Time
1436849.874  15252399.259 8.78 7.06 0.59 3.12 2.5 612.463 2 7 1.20 08:20:29.173
1436850.118  15252399.230 8.04 5.97 0.14 1.80 1.66 612.459 2 7 1.20 08:20:29.240
1436850.366  15252399.200 7.41 4.66 -0.53 1.13 1.65 612.455 2 7 1.20 08:20:29.308
1436850.603  15252399.172 1.36 -2.30 -1.30 -0.63 0.67 612.450 2 7 1.20 08:20:29.372
1436850.843  15252399.143 -2.75 -6.54 -2.94 -4.12 -1.18 612.446 2 7 1.20 08:20:29.439
1436851.091  15252399.114 -6.63 -9.90 -3.28 -5.00 -1.73  612.442 2 7 1.20 08:20:29.507
1436851.332  15252399.085 -13.34 -15.44 -3.94 -5.45 -1.51 612.437 2 7 1.20 08:20:29.573
1436851.572  15252399.056 -14.94 -16.52 -4.82 -5.90 -1.08 612.433 2 7 1.20 08:20:29.638
1436851.816  15252399.027 -13.94 -15.76 -5.48 -8.95 -3.47 612.429 2 7 1.20 08:20:29.706
1436852.053  15252398.999 -9.79 -12.40 -6.90 -11.13 -4.23  612.425 2 7 1.20 08:20:29.771
1436852.294  15252398.971 -8.69 -11.64 -8.21 -14.83 -6.62 612.420 2 7 1.20 08:20:29.836
1436852.545  15252398.941 -9.21 -10.55 -7.24 -11.80 -4.56 612.416 2 7 1.20 08:20:29.905
1436852.830  15252398.907 -9.41 -8.06 -4.32 -5.74 -1.42 612.411 2 7 1.20 08:20:29.984
1436853.078  15252398.877 -7.45 -5.67 -3.99 -5.96 -1.96 612.406 2 7 1.20 08:20:30.051
1436853.512  15252398.840 -6.66 -6.43 -4.98 -7.27 -2.29 612.406 2 7 1.20 08:20:30.170
1436853.762  15252398.820 -6.86 -5.89 -3.36 -2.95 0.42 612.406 2 7 1.20 08:20:30.238
1436854.001  15252398.800 -7.83 -4.05 -0.33 3.33 3.66 612.406 2 7 1.20 08:20:30.302
1436854.248  15252398.780 -8.46 -4.27 0.42 4.62 4.20 612.406 2 7 1.20 08:20:30.369
1436854.498  15252398.760 -10.39 -5.78 -0.35 4.61 4.96 612.406 2 7 1.20 08:20:30.438
1436854.734  15252398.740 -10.93 -5.68 0.62 6.12 5.50 612.406 2 7 1.20 08:20:30.502
1436854.976  15252398.721 -9.71 -4.70 2.35 10.44 8.09 612.406 2 7 1.20 08:20:30.567
1436855.227  15252398.700 -8.08 -3.08 2.88 12.81 9.93 612.406 2 7 1.20 08:20:30.636
1436855.466  15252398.681 -2.55 1.47 3.20 13.02 9.82 612.406 2 7 1.20 08:20:30.701
1436855.713  15252398.660 0.71 4.17 3.84 13.66 9.81 612.406 2 7 1.20 08:20:30.768
1436855.963  15252398.640 2.02 5.47 3.95 14.52 10.57 612.406 2 7 1.20 08:20:30.835
1436856.202  15252398.621 3.11 6.87 4.59 15.16 10.57 612.406 2 7 1.20 08:20:30.901
1436856.500  15252398.596 2.79 6.11 3.51 11.47 7.97 612.406 2 7 1.20 08:20:30.981
1436856.740  15252398.577 -1.85 0.60 1.66 7.79 6.13 612.406 2 7 1.20 08:20:31.047
1436857.172  15252398.549 -8.00 -6.65 -4.07 -6.71 -2.64 612.409 2 7 1.20 08:20:31.168
1436859.302  15252398.415 -7.64 -6.76 -2.62 -2.25 0.37 612.429 2 7 1.20 08:20:31.765
1436859.534  15252398.401 -2.02 -0.18 -0.03 3.15 3.18 612.431 2 7 1.20 08:20:31.831
1436859.769  15252398.386 -0.28 2.41 4.06 12.20 8.14 612.433 2 7 1.20 08:20:31.897
1436860.011  15252398.371 -0.16 3.17 5.35 14.79 9.43 612.436 2 7 1.20 08:20:31.965
1436860.243  15252398.357 -1.99 1.98 5.67 15.86 10.19 612.438 2 7 1.20 08:20:32.030
1436860.756  15252398.355 -3.27 -0.07 3.18 11.32 8.13 612.425 2 7 1.20 08:20:32.175
1436860.995  15252398.355 -3.81 -1.26 2.21 7.86 5.65 612.418 2 7 1.20 08:20:32.244
1436861.224  15252398.356 -4.66 -2.45 0.70 5.48 4.78 612.411 2 7 1.20 08:20:32.309
1436861.459  15252398.356 -5.19 -2.77 -0.82 0.94 1.76 612.405 2 7 1.20 08:20:32.376
1436861.698  15252398.356 -6.15 -3.10 -1.36 1.59 2.95 612.398 2 7 1.20 08:20:32.443
1436861.926  15252398.357 -6.36 -1.69 -0.18 3.31 3.48 612.391 2 7 1.20 08:20:32.509
1436862.158  15252398.357 -7.54 -2.23 -0.29 1.79 2.08 612.384 2 7 1.20 08:20:32.575
1436862.401  15252398.358 -9.36 -3.53 -1.70 -1.88 -0.19 612.377 2 7 1.20 08:20:32.644
1436862.626  15252398.358 -9.14 -4.93 -2.99 -5.55 -2.56 612.371 2 7 1.20 08:20:32.708
1436862.858  15252398.359 -9.35 -5.36 -3.86 -6.63 -2.78 612.364 2 7 1.20 08:20:32.774
1436863.097  15252398.359 -9.24 -5.47 -4.40 -6.85 -2.45 612.357 2 7 1.20 08:20:32.842
1436863.423  15252398.360 -9.45 -6.33 -5.26 -7.50 -2.24 612.348 2 7 1.20 08:20:32.935
1436863.652  15252398.360 -9.02 -6.98 -5.26 -8.58 -3.32  612.341 2 7 1.20 08:20:33.000
1436864.206  15252398.337 -6.10 -4.93 -4.84 -8.80 -3.96 612.335 2 7 1.20 08:20:33.162
1436864.428  15252398.327 -4.36 -3.42 -4.52 -7.30 -2.78 612.333 2 7 1.20 08:20:33.226
1436864.653  15252398.317 -2.73 -2.24 -2.58 -4.50 -1.92 612.331 2 7 1.20 08:20:33.293
1436864.885  15252398.307 0.19 -0.41 -0.97 -0.41 0.56 612.329 2 7 1.20 08:20:33.361
1436865.104  15252398.297 5.37 3.90 1.50 4.54 3.04 612.327 2 7 1.20 08:20:33.424
1436865.332  15252398.286 6.89 4.76 4.30 9.92 5.62 612.325 2 7 1.20 08:20:33.492
1436865.564  15252398.276 7.54 5.09 4.94 12.50 7.56 612.322 2 7 1.20 08:20:33.560
1436865.786  15252398.266 7.12 5.08 5.58 12.06 6.48 612.320 2 7 1.20 08:20:33.625
1436949.135  15252468.330 1022.27 774.30 546.19 583.53 37.34 613.111 2 8 1.10 08:33:47.592
1436949.398  15252468.332 1010.26 766.44 539.64 577.41 37.77 613.106 2 8 1.10 08:33:47.659
1436949.649  15252468.335 986.68 749.51 532.96 571.71 38.75 613.102 2 8 1.10 08:33:47.725
1436949.908  15252468.338 971.73 738.60 519.98 556.01 36.02 613.098 2 8 1.10 08:33:47.792
1436950.170  15252468.340 956.09 727.20 512.28 546.89 34.61 613.093 2 8 1.10 08:33:47.860
1436950.422  15252468.343 928.34 704.02 503.59 537.76 34.18 613.089 2 8 1.10 08:33:47.925
1436950.677  15252468.345 912.19 691.58 490.82 526.85 36.03 613.084 2 8 1.10 08:33:47.991
1436950.943  15252468.348 896.57 679.99 484.91 522.46 37.55 613.080 2 8 1.10 08:33:48.060
1436951.194  15252468.351 874.34 663.54 479.25 517.02 37.77 613.076 2 8 1.10 08:33:48.125
1436951.449  15252468.353 864.15 655.98 467.66 504.78 37.11 613.071 2 8 1.10 08:33:48.191
1436951.708  15252468.356 854.36 648.80 461.79 498.90 37.11 613.067 2 8 1.10 08:33:48.258
1436951.959  15252468.359 835.09 633.88 456.79 495.21 38.42 613.063 2 8 1.10 08:33:48.323
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B.6 Samples of GPS External Files

GPS files created by a GPS data processing software can be written in large variety of
ASCII formats. The TrackMaker61MK2 can read any ASCII format of the file as long
as delimiters between columns consists of comma or string of spaces, and time is in

the format hh:mm:ss. These files are used in Position Readings Using External GPS
Files option of TrackMaker61MK2. The user must specify where parameters needed by
TrackMaker61MK?2 are located (column number). The user must also specify what type
of coordinates is used in the GPS file.

Example of GPS file with Geodetic coordinates

The GPS file presented below contains coordinates in Geodetic format. Longitude is
located in column 1, Latitude in column 2, and Time in column 4. Please note, that in
this example Comma as well as Space is used as column delimiter which is acceptable for

TrackMaker61MK2.

-106.259952057,42
-106.259951531,42
-106.259951500, 42
-106.259943814,42
-106.259951552,42
-106.259951917,42
-106.259952005, 42
-106.259952763,42
-106.259944641,42
-106.259953247,42
-106.259958166,42
-106.259960245, 42
-106.259960253,42
-106.259952104,42
-106.259960094,42
-106.259960121,42
-106.259960098,42
-106.259959918,42
-106.2599520091,42
-106.259945692,42
-106.259954063,42
-106.259954276,42
-106.259954388,42
-106.259957706,42
-106.259959301,42
-106.259979673,42

.861338618,11/15/01
.861337514,11/15/01
.861337541,11/15/01
.861333925,11/15/01
.861337587,11/15/01
.861337327,11/15/01
.861337432,11/15/01
.861337307,11/15/01
.861333833,11/15/01
.861337437,11/15/01
.861337142,11/15/01
.861336674,11/15/01
.861336690,11/15/01
.861333303,11/15/01
.861336962,11/15/01
.861336957,11/15/01
.861336920,11/15/01
.861336612,11/15/01
.861333332,11/15/01
.861333854,11/15/01
.861338929,11/15/01
.861338752,11/15/01
.861338732,11/15/01
.861338375,11/15/01
.861333148,11/15/01
.861337490,11/15/01
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Example of GPS file with UTM coordinates

The GPS file presented below contains coordinates in UTM format. Easting in meters
is located in column 4, Northing in meters is placed in column 3, and Time is located in

column 3.

03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:
03/28/02,18:

:02,1285840.
:04,1285840.
:06,1285840.
:08,1285840.
:10,1285840.
:12,1285840.
:14,1285840.
:16,1285840.
:18,1285840.
:20,1285840.
:22,1285840.
:24,1285840.
:26,1285840.
:28,1285840.
:30,1285840.
:32,1285840.
:34,1285840.
:36,1285840.
:38,1285840.
:40,1285840.
:42,1285840.
:44,1285840.
:46,1285840.
:48,1285840.
:50,1285840.
:52,1285840.
:54,1285840.
:56,1285840.
:58,1285840.
:00,1285840.
:02,1285840.
:04,1285840.
:06,1285840.
:08,1285840.
:10,1285840.
:12,1285840.
:14,1285840.
:16,1285840.

932,462524
923,462524
922,462524
927,462524
930,462524
944 ,462524
957,462524
962,462524
960,462524
955,462524
947,462524
945,462524
946,462524
952,462524
958,462524
959,462524
957,462524
954,462524
957,462524
957,462524
966,462524
974,462524
973,462524
975,462524
974,462524
977,462524
971,462524
976,462524
973,462524
974,462524
983,462524
980,462524
979,462524
978,462524
982,462524
985,462524
984 ,462524
984 ,462524

.261,0.
.266,0.
.266,0.
.268,0.
.285,0.
.290,0.
.290,0.

.298,0.

.303,0.
.311,0.
.301,0.
.301,0.
.310,0.
.313,0.
.316,0.
.311,0.

.289,0.

.284,0.
.290,0.
.296,0.
.288,0.
.294,0.
.286,0.
.282,0.

.296,0.

.298,0.

.291,0.
.291,0.
.289,0.
.300,0.
.311,0.
.319,0.
.297,0.

.296,0.

.279,0.

.281,0.
.289,0.
.282,0.

24,0.
24,0.
24,0.
24,0.
24,0.
24,0.

24,0.
24,0.

24,0.
24,0.
24,0.
24,0.
24,0.
24,0.
24,0.

24,0.
24,0.

24,0.
24,0.
24,0.
24,0.
24,0.
24,0.
24,0.

24,0.
24,0.

24,0.
24,0.
24,0.
24,0.
24,0.
24,0.
24,0.

24,0.
24,0.

24,0.
24,0.
24,0.

34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
34,0.
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Selected NMEA Messages

GGA Data Message

The GGA message contains the GPS position information and it is the most widely used

NMEA data message. This message takes the following form:

$GPGGA ,hhmmss.ss,ddmm.mmmmm,s,dddmm.mmmmm,s,n,qq,pp.p,saaaaa.aa,u,

+xxxx.x,M,sss,aaaa*cc<CR><LF>

Definition of GGA message component:

hhmmss.ss UTC time in hours, minutes, seconds of the GPS position
ddmm.mmmmm Latitude in degrees, minutes, and decimal minutes

S s=N or s=S, for North and South latitude
dddmm.mmmmm Longitude in degrees, minutes, and decimal minutes

s s=E or s=W, for East and West longitude

n Quality indicator,

0 = no position, 1 = raw, no differentially corrected position,
2 = differentially corrected position (DGPS), 4 = Real-time
kinematic, fixed integers, 5 = Real-time kinematic, float inte-

gers, 9 = position computed using almanac information

qq Number of satellites used in position computation
Pp-p HDOP = 0.0 t0 99.9

saaaaa.aa Antenna altitude

u Altitude units, M=meters

+XXXX.X Geoidal separation (requires geoidal height option)

M Geoidal separation units, M = meters

SSS Age of differential corrections in seconds

aaaa Base station identification

*cc Checksum

<CR><LF> Carriage return and Line feed
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GSA Data Message

The GSA message contains active satellites and PDOP value. The GSA message is given
in the following form:

$GPGSA,c1,d1,d2,d3,d4,d5,d6,d7,d8,d9,d10,d11,d12,d13,f1,£2,f3*cc< CR> <LF>

Definition of GSA message components:

cl Mode, M = manual, A = automatic
d1 Mode, 2 = 2D, 3 = 3D
d2-d13 Satellites used in position computation (range 0 to 32)
f1 PDOP (range 0 to 99.9)
2 HDOP (range 0 to 99.9)
f3 VDOP (range 0 to 99.9)
*cc Checksum
<CR><LF> Carriage return and Line Feed
POS Data Message

The POS message contains the GPS position information and PDOP value. The POS
message is given in the following form:

$PASHR,POS,n,qq,hhmmss:ss,ddmm.mmmmm,s,dddmm.mmmmm,s,saaaaa.aa,seeeee,
ttt,ggg,svvv,pp,hh,vv,tt,vvwv*cc<CR> <LF>

Definition of POS message components:
n Quality indicator,

0 = no differentially corrected position,
1 = differentially corrected position

qq Number of satellites used in position computation
hhmmss:ss UTC time in hours, minutes, seconds of the GPS position
ddmm.mmmmm Latitude in degrees, minutes, and decimal minutes

S s=N or s=S, for North and South latitude
dddmm.mmmmm Longitude in degrees, minutes, and decimal minutes

s s=E or s=W, for East and West longitude

saaaaa.aa sensor computed altitude

seeeee reserved
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ttt

ggg
SVVV

pp

hh

A%

tt

VVVV

*cc
<CR><LF>

LLK Data Message

True track/true course over ground in degree
Speed over ground (knots)

Vertical velocity (decimeters per second)

PDOP - position dilution of precision (00 to 99)
HDOP - horizontal dilution of precision (00 to 99)
VDOP - vertical dilution of precision (00 to 99)
TDOP - time dilution of precision (00 to 99)
firmware version ID

Checksum

Carriage return and Line feed

The LLK (Leica Local Position and GDOP) message provides position in local coordi-
nates in meters and GDOP value. The LLK message is given in the following form:

$GPLLK,hhmmss.ss,ddmmyy,xxxx.xxxx,M,XXXX.XXXX, M,X,X,XX.XX,XXXX.XXXX,M,

*cce<CR><LF>

Definition of LLK message components:

hhmmss.ss
ddmmyy
XXXX.XXXX
M
XXXX.XXXX
M

X

X
XX.XX
XXXX.XXXX

M

*cc
<CR><LF>

UTC time in hours, minutes, seconds of the GPS position
UTC date (day, month, year)

Grid Easting, meters

Meters (fixed text “M™)

Grid Northing, meters

Meters (fixed text “M™)

Quality indicator,

0 = not valid,

1 = GPS Nav Fix (no differentially corrected position),
2 = DGPS Fix (differentially corrected position),

3 = RTK Fix

Number of satellites used in computation,

GDOP

Height, meters

Meters (fixed text “M”)

Checksum

Carriage return and Line feed
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LLQ Data Message

The LLQ (Leica Local Position and Quality) message provides position in local coordi-
nates in meters and position quality in meters. The LLQ message is given in the follow-
ing form:

$GPLLQ,hhmmss.ss,ddmmyy,xxxx.xxxx, M,XXXX.XXXX,M,X,X,XX.XX,XXXX.XXXX,M,
*cc<CR><LF>

Definition of LLK message components:

hhmmss.ss UTC time in hours, minutes, seconds of the GPS position
ddmmyy UTC date (day, month, year)
XXXX.XXXX Grid Easting, meters
M Meters (fixed text “M”)
XXXX.XXXX Grid Northing, meters
M Meters (fixed text “M”)
X Quality indicator,
0 = not valid,

1 = GPS Nav Fix (no differentially corrected position),
2 = DGPS Fix (differentially corrected position),

3 = RTK Fix
X Number of satellites used in computation,
XX.XX Position quality, meters
XXXX.XXXX Height, meters
M Meters (fixed text “M”)
*cc Checksum
<CR><LF> Carriage return and Line feed

GLL Data Message

The GLL message takes the following form:
$GPGLL,ddmm.mmmmm,s,dddmm.mmmmm,s,hhmmss.ss,s*cc<CR><LF>
Definition of GLL message component:

ddmm.mmmmm Latitude in degrees, minutes, and decimal minutes
S s=N or s=S, for North and South latitude
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dddmm.mmmmm
S

hhmmss.ss

S

*ce
<CR><LF>

GGK Data Message

Longitude in degrees, minutes, and decimal minutes
s=E or s=W, for East and West longitude

UTC time in hours, minutes, seconds of the GPS position
Status,

A = valid, V = invalid

Checksum

Carriage return and Line feed

The GGK message contains the GPS position, Time, Date, Position Type, and DOP in-
formation. The GGK shown below is not a standard NMEA data message and it is used
in several Trimble GPS receivers. If this message is used as a standard NMEA statement
by a given GPS receiver it starts with SGPGGK and contains GDOP instead of DOP.

TrackMaker software automatically recognizes which type of GGK message is used.

The Trimble proprietary type of GGK message takes the following form:

$PTNL,GGK,hhmmss.ss,ddmmyy,ddmm.mmmmmmmm,s,dddmm.mmmmmmmin,s,
n,qq,p.p,EHT-aa.aaa,M*cc<CR><LF>

Definition of GGK message component:

hhmmss.ss

ddmmyy
ddmm.mmmmmmmm
S
dddmm.mmmmmmm
S

n

aq

UTC time in hours, minutes, seconds of the GPS position
Date

Latitude in degrees, minutes, and decimal minutes

s=N or s=S, for North and South latitude

Longitude in degrees, minutes, and decimal minutes

s=E or s=W, for East and West longitude

GPS Quality indicator,

0 = fix not valid or not available,

1 = Autonomous GPS fix, no differentially corrected position,
2 = differential, floating carrier phase integer based solution
(FLOAT),

3 = differential, fixed carrier phase integer-based solution
(FIXED),

4 = differential, code phase only solution (DGPS)

Number of satellites used in fix
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p.p DOP of fix

EHT-aa.aaa Ellipsoidal height of fix

M unit of measure for ellipsoidal height in meters
*cc Checksum

<CR><LF> Carriage return and Line feed
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